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About Citrix Licensing 11.14
Aug 14 , 20 17

What 's new in Windows builds
T hese new or enhanced features in Build 21103.
Cit rix Licensing Manager Enhancement s. Displays license details after licenses are installed using a license access
code or downloaded file.
T hese new or enhanced features in Build 20104.
Cit rix Licensing Manager Enhancement s. T hese enhancements have been added to the Citrix Licensing Manager:
Install licenses by using the license access code or a license file (.lic).
Retry failed usage statistic uploads to Citrix.
Server configuration screen displays last upload information.
T hese new or enhanced features in Build 19005.
P roxy set t ings. Windows automatic proxy detection is enabled for components requiring outward bound web
communications. T he License Server automatically detects the proxy in its environment and communicates to the
intended recipient without manual intervention.
Not available in License Server VP X.
Cit rix Licensing Manager Enhancement s. Checks the availability of Subscription Advantage renewal licenses and can
notify you of their existence or automatically install the licenses.
Allows anytime configuration of Citrix Customer Experience (CEIP) and Call Home. Set this configuration during install or
upgrade. Call Home is a collection of basic usage and statistical information). For more information, see Citrix Licensing
Customer Experience Improvement Program (CEIP) and Call Home.
Not available in License Server VP X.
T hese new or enhanced features in Build 17005.
Cit rix License Management Service . Allows for license management and support.
Links to Citrix Insight Services to provide you with a license management console.
Enables better Citrix support of your license environment.
Provides essential information for you to understand and control your license environment while your organization
grows.
For more information, see Citrix License Management Service.
Dat abase st orage - Database stores and exports the historical use data, increasing performance.
What 's new in VP X builds
T his new or enhanced feature in Build 17000.
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New version of t he Cit rix License Server VP X. T he self-contained Linux-based virtual appliance that allows
deployment of licensing in your Citrix environment.
T hese new or enhanced features in Build 16100.
New version of Cit rix License Server VP X. A self-contained Linux-based virtual appliance that allows deployment of
licensing in your Citrix environment. License Server VPX contains a script to export and import licenses and data and move
between VPX releases. You can bring the appliance online by:
Importing the appliance to your host or pool of hosts.
Configuring basic networking - specifying IP address, hostname, and other network information.
Using the License Administration Console to upload licenses for your hosts.
Call Home. Call Home capabilities have been extended to detect Citrix Service Provider licenses and report product
usage to Citrix. For more information, see Citrix Licensing Customer Experience Improvement Program (CEIP) and Call
Home.

For more information about version numbers, see Differences in License Server version numbers.

Important
We recommend that you run the latest version of the License Server. Citrix does not provide hotﬁxes for License Server
components and does not support older License Servers with newer products. T he latest versions of the License Server often
contain resolutions to issues appearing in earlier versions. When you upgrade or install new Citrix products, upgrade the licensing
components too. New License Servers are backward compatible and support older products and license ﬁles. However, new
products often require the newest License Server to check out licenses correctly. You can ﬁnd the latest version from the Citrix
Downloads site.

To ﬁnd your License Server version number
When you are unsure if your License Server version is current, you can verify it by comparing your version to the number on
the Downloads site.
On a License Server wit h t he License Administ rat ion Console
1. Start the License Administration Console from the programs menu: Citrix > Management Consoles > License
Administration Console.
2. Select Administration and select the System Information tab. See the release version in the information list.
On a License Server wit hout t he License Administ rat ion Console
1. Open the Registry Editor (Start > Run > regedit).
Note: Use Registry Editor to view the license server information only. Editing the Registry can cause serious problems
that might require you to reinstall your operating system.
2. Navigate to HKEY_LOCAL_MACHINE\SOFT WARE\Citrix\LicenseServer\Install.
T he version number appears in the Version key in the format, for example: 11.14.0.1 build 16100.
On servers running Windows 2008 Server 64-bit, the registry key is
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HKEY_LOCAL_MACHINE\SOFT WARE\Wow6432Node\Citrix\LicenseServer\Install
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Known and ﬁxed issues
May 22, 20 17

T his article contains:
Installation issues
Other known issues
Other known issues and considerations - License Server VPX Only
License ﬁle issues
Fixed issues

Known issues
If Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled (the default configuration for
Windows 2008), connections can fail. Connecting remotely to the console or checking out licenses works until failover
occurs in the cluster. Exception rules for CIT RIX.exe and lmadmin.exe are created during installation of Licensing and
Simple License Service, but do not work after a cluster failover. T o work around this issue, create exceptions for Licensing
components on the Exceptions tab of the Windows Firewall panel. Create an exception for each of the following ports:
Console Web Server port (default port is 8082); License Server Manager port (default port is 27000); Simple License
Service port (default port is 8083); and Vendor Daemon port (default port is 7279). T his issue occurs with Windows Server
2008 (32-bit and 64-bit), Windows Server 2008 R2, and Windows Server 2012. For more information,
seehttp://support.microsoft.com/kb/2568645.
[#232365]
During the installation, the Configuration page is presented. If you choose not to configure the License Server, you can
configure it at a later time. You must restart the License Server installer or use the configuration tool. You can open the
tool from: C:\Program Files\Citrix\Licensing\LS\resource\Licensing.Configuration.T ool.exe. If the License Server
Configuration tool fails for any reason, uninstall and reinstall the License Server.
During installation, localized characters in the installation path can cause the installation to fail. Accept the default
installation path or enter only ASCII alphabetic letter characters for the installation directory.
[#229456]
When configuring the product-side setting for the License Server name, do not use localhost. T hough you can use the
host name, IP address, or FQDN instead, Citrix recommends you use the FQDN.
[#165986]
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When you have the Citrix License Server 11.11.1 and greater installed and then install XenDesktop 5.6, the 30-day free
trial license is the only license available to you. Workaround: Accept the trial license and complete the installation. Use
Desktop Studio to change the product edition and license model settings after the installation.
[#388512]

T he udadmin command might not delete licenses when there is an apostrophe in the device name.
Workaround: Use a backslash to escape the apostrophe. For example, udadmin.exe -f XDT _P LT _UD -device "jim\'s"
-delet e
[#LIC-142]
When using Internet Explorer 9 or 10, the Citrix Licensing Manager page might be blank or icons might not display. One of
these items might be the reason:
Compat ibilit y view mode is Of f - T urn on Compatibility View mode.
Browser script s are disabled - Enable browser scripts.
Caching of act ive document s is enabled - Navigate to Internet options > Advanced > Security and clear Do not
save encrypted pages to disk.
Assigning a busy port to the vendor daemon or License Administration Console might result in the vendor daemon going
down or the Licensing Administration Console becoming inaccessible.
Windows - T he vendor daemon goes down if you update the vendor daemon port by using a port that is already
busy followed by a service restart. Access the License Administration Console and update the vendor daemon port by
using a valid free port followed by a restart to restore License Server.
VP X - T his situation requires a support call.
T he username is case sensitive in some localized languages. T o log on to Citrix Licensing Manager, set thedomainname\username in UPPER CASE if it contains non-ASCII characters.
[#595621]
If you upgrade an older, existing cluster to 11.12.1, the message, "T he installation drive is not part of the selected cluster
group. Select the correct cluster group or add the drive to the selected group." displays. T o successfully use the new
11.12.1 clustering features, you must uninstall any License Server older than 11.12.1. T he older License Servers do not
conform to current Microsoft cluster guidelines.
When you try to start the License Administration Console or the Citrix Licensing Manager, a blank page might display if
the Internet Explorer Enhanced Security Configuration is enabled and the License Administration Console or the Citrix
Licensing Manager is not in the T rusted Sites. Workaround: Disable Internet Explorer Enhanced Security Configuration.
[#382429]
When you access Citrix Licensing Manager from the Start menu for the first time after installation, an error message
might appear on Firefox and Chrome browsers.

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.7

[#LIC-195]
Older Desktop Studio releases (prior to XenDesktop 7 Studio) using this version of the License Server do not display
license usage information or manage the License Server using the Licensing Node. T his version of the License Server is
fully compatible with XenDesktop and can serve licenses for any Citrix product deployment. If you continue to use an
older Desktop Studio, use the License Administration Console that ships with the License Server to display license usage,
manage License Server users, and upload licenses. If you are using a version of XenDesktop prior to the XenDesktop 7
and you upgrade from earlier versions of Citrix License Server for Windows to version 11.11.1 and 11.12.1, you might see
the following warning:
Warning: Installing this update removes the Licensing Conﬁguration Service. As a result, all versions prior to this release of
Studio provide only limited licensing information.
On non-English platforms, when starting a License Service installation on a cluster node, the Cluster Group list on the
Configure screen might contain the system default Cluster Group. Select one of the non-default Cluster Groups and the
installation continues normally.
[#497524]

In License Server Configuration on the License Administration Console, don't choose Def ault P ort for the License
Server Manager and restart Citrix Licensing Service. Choosing this option results in an inaccessible License Server.
Workaround: Choose the Use t his P ort option, fill in a free port number, and then restart the Citrix License Service.
[#LIC-180]
Studio does not display license usage information or manage the License Server. Use the License Administration Console
that ships with the License Server to display license usage, manage License Server users, and upload licenses.
When configuring XenDesktop 7.0 through 7.13 or XenApp 7.5 through 7.13, use the PowerShell Set-Configsite cmdlet
to point to License Server VPX. If doing a fresh install, install and configure XenDesktop and XenApp using its installer,
and then use PowerShell to reconfigure and point to License Server VPX.
Set-ConﬁgSite -LicenseServerName <DNS_name/IP_of_licence_server> -LicenseServerPort <port>
Ports 1 through 1024 are reserved by the operating system. When configuring the VPX ports, use ports higher than 1024.
By default, VPX uses port 8082 for SSL, which is open in the firewall. If you choose a different port for SSL, reconfigure
the firewall in the iptables.
Upgrades are not supported for License Server VPX.
T he License Server VPX does not support Active Directory.

Certain license types are not covered by Subscription Advantage. T herefore they appear in alerts in the Dashboard of
the License Administration Console indicating that the Subscription Advantage date is expired. You can ignore such alerts
for any license not covered by Subscription Advantage. T his includes Evaluation licenses, Not for Resale licenses, Early
Release licenses and T echnology Preview licenses. T hese types of licenses do not need Subscription Advantage and your
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Citrix products do not stop working when the Subscription Advantage date is expired. You can verify the status of any
license for which you receive an alert by clicking the license on the Dashboard. T he license information expands to show
the license type (such as T echnology Preview), the license expiration date, and the Subscription Advantage date.
[#231847]
T he License Server ignores license files with multiple lines referencing HOST NAME=. Licenses in these files cannot be
checked out. T his issue is caused when you download licenses associated to different License Server hostnames into the
same license file. T he License Administration Console displays the following error message: "...Error List
Returned...Unknown Host."
To resolve this issue, download again separate license ﬁles for each Citrix product tied to different License Server names.
After you replace evaluation license files on the License Server with new license files, the Citrix product might continue
to display the following license expiration message when users log on: "Warning: T he following Citrix Product is using an
Evaluation license. T his license will expire in..."
To resolve this issue:
1. Remove the old evaluation license files from the License Server. (See Delete license files in Citrix documentation.)
2. At the License Server, restart the Citrix Licensing service.
3. At the Citrix product server that needs license validation, point to a fictional License Server and then point the
product back to the actual License Server. (See your product documentation for information about changing these
settings.)
4. If the problem persists, restart the product server (for example, Delivery Controller).

Fixes issues
F ixed in Build 20104 :
When you try to start the Citrix Licensing Manager and Firefox is the default browser, the Citrix Licensing Manager is
inaccessible and Firefox displays a generic error message.
[#LIC-107]
Failed Citrix Licensing Manager upload notifications are not deleted after you disable CEIP and Call Home.
[#LIC-188]
F ixed in Build 18001:
T his fix deletes occasional rogue characters from the Citrix License Management Console.
[#LC5354]
F ixed in Build 17 005:
lmhostid returns blank when it is queried to return an IPv6 type of address.
[#621679]
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Third party notices
May 22, 20 17

Citrix Licensing 11.14 might include third party software licensed under the terms deﬁned in the following documents:

Non-Commercial Software Disclosures For FlexNet Publisher 2016 R1 (11.14.0.0)
FlexNet Publisher Documentation Supplement Third Party and Open Source
Software used in FlexNet Publisher 11.14.0
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System requirements for Citrix Licensing
Aug 14 , 20 17

Citrix Licensing is compatible with the same hardware required to support the compatible operating systems. No additional
hardware is required.

Note
T he license server does not support multi-homing (two network cards plugged into distinct networks).
T he License Administration Console manages the License Server on the computer on which it is installed. It cannot manage
remote or third party License Servers. T he Citrix Licensing Manager can install licenses only on the License Server where it is
installed. We recommend installing the License Server on server operating systems only. T he consoles can be accessed from
any server or client operating system using a web browser. License Servers cannot communicate with each other.
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You can install the license server on servers running the following Microsoft operating systems. Citrix
recommends that you install the latest Microsoft Service Pack and updates.
Windows Server 2016 Family
Windows Server 2012 R2 Family
Windows Server 2012 Family
Operating system

Windows Server 2008 R2 Family
Windows 10, 32-bit and 64-bit editions (not supported with Build 18001 or later)
Windows 8.1, 32-bit and 64-bit editions (not supported with Build 18001 or later)
Windows 8, 32-bit and 64-bit editions (not supported with Build 18001 or later)
Windows 7, 32-bit and 64-bit editions (not supported with Build 18001 or later)

161 MB for the licensing components
Disk space

2 GB for user/device licensing

requirements

Microsoft .NET
Framework

Microsoft .NET Framework 3.5 SP1 or greater is required.

requirements
Windows Server 2016 Family
Windows Server 2012 R2 Family
Cluster platforms

Windows Server 2008 R2 Family
Safari on Mac

We tested the following browsers. Other browsers might work, but all functionality might not be available.
Internet Explorer Version 11
Microsoft Edge
Browsers

Mozilla Firefox
Chrome
Safari

XenServer must provide adequate virtual computing resources to the License Server VPX as listed in this table.
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512 MB. Sufﬁcient for up to 500 Citrix servers and approximately 50,000 licenses. Monitor available memory during
Memory

operation to determine if you require more memory. For larger environments, we recommend allocating more
memory.

XenServer
version

XenServer 6.1, 6.2, 6.5, 7.0, and 7.1.

Minimum
Storage

8 GB on the default Storage Repository inside the XenServer pool

Requirement
Virtual CPU
(vCPU)

1 vCPU. For larger environments or those using user/device licensing, consider adding a second vCPU.

We tested the following browsers. Other browsers might work, but all functionality might not be available.
Internet Explorer Version 11
Microsoft Edge
Browsers

Mozilla Firefox
Chrome
Safari
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Technical overview
Aug 14 , 20 17

Before you can use your Citrix product, you must install Citrix Licensing. Citrix Licensing is a system of components that
function together. T his system includes:
License server. A system that allows licenses to be shared across the network.
License f iles. T he files needed to license your product. T hese files are stored on the License Server.
Cit rix Licensing Manager. Enables the following:
Display details of licenses after they are installed using a license access code or downloaded file. - Build 21103
Allocation and installation of license files on a License Server using a GUI.
Installation of licenses by using the license access code or a license file (.lic).
Configuration of Customer Experience Improvement Program (CEIP) and Call Home.
Retry failed usage statistic uploads to Citrix.
Automatically or manually checks for Subscription Advantage renewal licenses and notifies you or installs the licenses
if found.
Enables the creation and exporting of License Server historical usage reports and configuration of historical data
retention. Default data retention is 180 days.
Notifies you of the License Server state - Missing startup license, time issues, uploader failures.
Not available in License Server VPX.
License Administ rat ion Console. T he interface you use to manage your license files and your License Server.
Web Services f or Licensing. Enables Studio, Director, and the Licensing Administration PowerShell Snap-in to:
Communicate with the License Server and manage users.
Allocate and install licenses.
Display License Server health, license usage, and other alert messages.
Not available in License Server VPX.
Cit rix License Management Service. Enables management of your license environment through a license
management console within Citrix Insight Services. T his service assists with license management and support:
Allocating new licenses if you are about to exceed your license capacity
Rescinding old licenses after an upgrade
Managing duplicate licenses in a Disaster Recovery (DR) environment
P roduct -side set t ings in your Citrix products that are associated with the License Server.
For more information, see Licensing components and Consoles and services.

Every Citrix product environment must have at least one shared or dedicated License Server. License servers are computers
that are partly or completely dedicated to storing and managing licenses. Citrix products request licenses from a License
Server if users attempt to connect.
Servers running Citrix products contact the License Server to obtain licenses.
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If users connect to a Citrix product, it draws licenses from the License Server. T hat is, the Citrix product requests to check
out a license from the License Server on behalf of the user or client device. When the license is successfully checked out,
the user can run the product.
Depending on the size and conﬁguration of your product deployment, you might deploy licensing on a server shared with
other applications, a dedicated License Server, or multiple License Servers.
License ﬁles must be on the License Server that is associated with the product you are licensing. T he product must be
conﬁgured to communicate with that speciﬁc License Server. T he License Administration Console lets you manage and
monitor your Citrix licenses by providing a user interface to the License Server. You can view a dashboard of licenses and
alerts, import license ﬁles, and manage License Server settings.

Typically, the ﬁrst time a user connects to a Citrix product, the product requests a license from the License Server. When the
License Server grants a license request, the Citrix product reserves a license for its use. Reserving licenses for this purpose is
known as checking out licenses. When the user logs off from the product server, the product returns the license to the
License Server. T his process is known as checking in licenses. Some Citrix products check out the license when a user
connects to the product, and the license remains checked out for a predetermined amount of time.
Each time a Citrix product starts, it opens a connection to the License Server by checking out the startup license. T he
startup license is a Citrix system ﬁle that enables Citrix products to maintain a continuous connection to the License Server.
T he following ﬁgure shows that each product forms its own constant connection to the License Server.
Citrix tests single license server scalability up to approximately 340,000 concurrent licenses (maximum before the 32-bit
CIT RIX process runs out of memory) and 1,000,000 user/device licenses.
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For example, when a server running XenDesktop requests a license, the product retrieves the License Server name and port
number information from the data store. T he product then establishes a connection to acquire the appropriate licenses.
T here are three stages of the license checkout process.

A Citrix product goes through a three-step process to check out licenses:
1. At startup, a computer running a Citrix product checks out a startup license.
2. A client device connects to the product server.
3. T he product requests a license from the License Server.
Citrix products, such as XenDesktop, store a replica of the licensing information from the License Server, including the
number and type of licenses. If a Citrix product server loses its connection to the License Server, or the License Server does
not respond in a timely manner, the product enters a grace period. During the grace period, the product uses its local record
of the licenses to continue licensing the product. Citrix products update this record every hour.
Grace periods
If product servers lose communication with the License Server, the users and the products are protected by a grace period.
T he grace period allows the product servers to continue operations as if they were still in communication with the License
Server. After the Citrix product checks out a startup license, the product and the License Server exchange "heartbeat"
messages every ﬁve minutes. T he heartbeat indicates to each that they are still up and running. If the product and the
License Server don't send or receive heartbeats, the product lapses into the licensing grace period and licenses itself
through cached information.
Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. T he Windows Event Log, and
other in-product messages, indicate if the product has entered the grace period, the number of hours remaining in the
grace period. If the grace period runs out, the product stops accepting connections. After communication is re-established
between the product and the License Server, the grace period is reset.
T he grace period takes place only if the product has successfully communicated with the License Server at least once.

Grace period example - two sites, both using the same License Server
T he connection between Site 1 and the License Server goes down causing Site 1 to go into the grace period, continuing
operation and making connections. For concurrent licenses, they can connect up to the maximum concurrent licenses
installed. For user/device licenses, they have unlimited connections. When Site 1 reestablishes communication with the
License Server, connections are reconciled and no new connections are allowed until they are within normal license limits.
Site2 is unaffected and operates as normal.
If the License Server goes down, both sites go into the grace period. Each site allows up to the maximum number of
licenses installed. As above, the user/device licenses have no limit.
Supplement al grace period
For the supplemental grace period to be available, you must use a minimum of XenApp 7.6 or XenDesktop 7.6.
If all licenses are in use, supplemental grace period enables unlimited connections to a product, allowing you to understand
and address the issue. T his period lasts until 15 days elapses or you install more retail licenses, whichever comes ﬁrst. We
recommend that after the supplemental grace period starts, you allow it to run out rather than adding licenses immediately
to clear the warning condition.
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After the period expires, normal connection limits are enforced. Users are not disconnected, but as they disconnect, no new
connections can occur until license levels return to normal.
Once the supplemental grace period completes, it isn't automatically reenabled. To reenable the supplemental grace period,
install another retail license, and then normal license limits are enforced. When you reeneable the supplemental grace period
by installing the new retail license, a new 15-day supplemental grace period starts the next time you exceed maximum
installed licenses.

Note
If you install licenses while the supplemental grace period is in force, the License Server exits the supplemental grace period.
Reenabling the supplemental grace period before determining the reason for the supplemental grace period might cause you to
reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail licenses.
T he supplemental grace period is enabled by default when you ﬁrst install licenses. To disable it, add the following line to
the CIT RIX.opt ﬁle and restart the Citrix licensing services:
#CIT RIX SGPOFF
Supplement al Grace P eriod example:
If you have a maximum count of 1000 licenses installed, and you make another connection (maximum licenses + 1), the
supplemental grace period starts. You then have a temporary, 15-day period giving you extra capacity to deal with
unforeseen capacity issues.

Important
T he supplemental grace period and license overdraft are two different features. T he supplemental grace period is a feature of
the product and the License Server. License overdraft is a feature of the license. For information about license overdraft, see
License overdraft.
License Server VPX does not support supplemental grace periods.
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Licensing components
May 22, 20 17

T he License Server comprises several licensing components:
Citrix vendor daemon
License ﬁles
Startup license
Citrix License Server Diagnostics License|Server
Options ﬁle
Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home
Figure 1. License Server Components. T his diagram shows the Citrix product using TCP/IP to connect to License Server
components.

T he Citrix vendor daemon (CIT RIX), a process that runs on the License Server, grants licenses. T he Citrix vendor daemon
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tracks the number of licenses that are checked out and which product has them. Citrix products communicate with the
Citrix vendor daemon using TCP/IP. By default, the Citrix vendor daemon uses TCP/IP port 7279.

License ﬁles are protected text ﬁles created by Citrix that store licensing data. T hey contain information about the product
licenses and the number of licenses, and system information such as the name of the License Server. T he License Server
uses these ﬁles to determine whether to grant a license to a Citrix product. For more information, see License ﬁles.

T he startup license (citrix_startup.lic) allows Citrix products to communicate with the License Server using a continuous
open connection. T he startup license:
T racks which product servers are connected to the License Server
Stores licensing system information
Does not affect your license count
Caut ion: Do not edit t he st art up license ﬁle, or any ot her license ﬁles.

Citrix License Server Diagnostics License|Server
T he License Server uses Citrix License Server Diagnostics License|Server for internal diagnostics and alert message
notiﬁcations displayed in Studio and Director. It is available by default with the startup license in the citrix_startup.lic ﬁle.

T he options ﬁle (Citrix.opt) is a License Server conﬁguration ﬁle that the Citrix vendor daemon reads every time it restarts or
receives a command to reread the ﬁle. T his conﬁguration ﬁle deﬁnes licensing behavior-the number of licenses a product
server can use, the location of the System Logs, logging levels, and other user-deﬁned customizations. T he Customer
Experience Improvement Program (CEIP) and Call Home conﬁgurations are stored in this ﬁle.

Important
T hough Flexera offers ways to edit the options ﬁle to control, reserve or limit licensing usage, they are not compatible with Citrix
licenses. T herefore, we do not support those editing options.

When a product requests a license from the License Server, the Citrix vendor daemon determines whether a license is
available for the request.
T he license request process has two phases: the product startup phase and the user connection phase.
P roduct St art -Up P hase
When a Citrix product starts, it retrieves the License Server location from its data store
T he product connects to the Citrix vendor daemon
T he product checks out a startup license
User connect ion phase
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A user connects to a computer running the Citrix product
T he product requests a license from the License Server
T he Citrix vendor daemon checks to see if any licenses are available and grants or denies the product's request
T he license module in the product grants or denies the use of the product based on the response from the Citrix vendor
daemon

T he Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to
improve your product experience. After installing License Server 11.13.1 and greater, you can participate in the programs
anonymously or choose to be identiﬁed.
CEIP is enabled by default during License Server installation. You can change your participation in the program at any time
by using the Citrix Licensing Manager.
T his screenshot was taken from build 20104. Older versions are only slightly different.
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Important
T he Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can
change the settings, but you cannot disable CEIP or Call Home. When the License Server detects Citrix Service Provider licenses, it
enforces daily uploads.

When installing licensing on the command line, use CEIPOPT IN to specify whether, or how, to opt in to CEIP or Call Home
Optional parameter. T he default is CEIP.
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Diagnostic - Call Home
Anonymous - CEIP
None
For more command-line installation information, see the "Use the command line to install licensing" section under Install
licensing components for Windows.
You can change the choice made at installation by editing the CIT RIX.opt ﬁle:
#CIT RIX CEIP value
Where value is DIAG, ANON, or NONE
On VPX, do not change the CIT RIX.opt ﬁle. As root, execute the following command and make your choice of CEIP [1.DIAG
2.ANON 3.NONE]
# reset _ceip.sh

Citrix Licensing Customer Experience Improvement Program (CEIP)
CEIP is voluntary. When you opt in, the CEIP services running in Citrix products gather anonymous conﬁguration and usage
data from your deployment. T he services automatically send the data to Citrix once a week, based on the service start
time. CEIP collects these classes of data:
Configuration data
Performance and reliability data
How your privacy is protected:
Citrix does not collect any personally identifiable data.
Random identifier is created at install time, which tracks data transfers over time.
Citrix does not record information such as IP addresses, server names, or domain names.
All data is sent using HT T PS directly to Citrix servers - no third-party data hosting services.
All data is secured on Citrix servers and is accessible only by authorized individuals.

Citrix Call Home
Call Home is voluntary. When you opt in, Call Home performs periodic collection of system and product conﬁguration,
performance, errors, and more. T he data identiﬁes you as a customer. T his information is transmitted to Citrix Insight
Services once a week, based on the service start time. Citrix support and product teams use the information to resolve
issues proactively.
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Consoles and services
Aug 14 , 20 17

Citrix Licensing Manager
License Administration Console
Web Services for Licensing
Citrix License Management Service
Citrix licensing Windows Management Instrumentation (WMI)

T he Citrix Licensing Manager enables the following features on a License Server using a simple web interface:
Display details of licenses after they are installed using a license access code or downloaded file. - Build 21103
Install license files (.lic) downloaded from citrix.com.
Retry failed citrix.com and Customer Experience Improvement Program uploads.
Simplified allocation and installation of license files on the License Server.
Automatically (or manually) checks for Subscription Advantage renewal licenses. You can specify whether to check
automatically or manually for renewal licenses and whether you want notification of renewal licenses or the licenses
installed. For more information on configuring this feature, see Check for and install Subscription Advantage renewal
licenses with the Citrix Licensing Manager.
Configure historical data retention by selecting a retention period on the Set t ings page. Default data retention is 180
days.
Important notifications of license availability, expiration, and other conditions. Use the bell icon at the top of the Citrix
Licensing Manager screen to display notifications.
Store and export historical usage reports from the License Server on which the tool is installed. You can specify a date
range for the historical usage data and export it to a CSV file. T he CSV file provides daily usage information including the
number of licenses in overdraft. For information about exporting historical usage data, see Export historical usage data
by using the Citrix Licensing Manager.
Configure the following:
Citrix Licensing Manager port
Display language
Historical data retention period
Update license and Subscription Advantage options
Customer Experience Improvement Program (CEIP) and Call Home.
T he Citrix Licensing Manager operates automatically within the License Server and is not available with License Server VPX.

T he License Administration Console lets you manage and monitor your Citrix licenses through a web browser.
Use the Dashboard to:
Monitor licenses, license activity, and alerts
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Use the Administration area to:
Administer licenses
Configure console users
Configure alerts
Import licenses
Log license management activities
Secure the console server
View system information
Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the
Administration area requires administration privileges and is password-protected.
For more information, see Manage with License Administration Console.

License Server VPX does not support Web Services for Licensing.
Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing to do the following:
Communicate with the License Server and manage users
Allocate and install licenses
Display License Server health, license usage, and other alert messages.
T he Citrix Licensing Manager also uses it.

T he License Management Service enables better capacity planning and license management. T his service also helps you
avoid prohibited practices:
Duplication of licenses outside a Disaster Recovery (DR) environment
Use of legacy licenses for new product versions
Use of rescinded licenses
T his service further alerts the administrator in Citrix Insight Services about duplicate licenses in a Disaster Recovery (DR)
environment. For more information about Citrix Insight Services, see Citrix Insight Services.
T he License Management Service uses product telemetry, built into the License Server, to send data to Citrix Insight
Services. T he ﬁrst upload occurs one week after the License Server ﬁrst starts and subsequent uploads occur every week
thereafter. T he schedule resets if you reinstall the License Server. If an upload fails, another attempt is made in 24 hours
until either the upload succeeds or you disable the License Management Service. Citrix might use uploads to help you
understand and support your license environment. See Use the command line to disable or enable the License Management
Service.

Important
Your installation of the License Server constitutes your acknowledgement of the License Management Service and your consent to
use the License Management Service. You can disable the License Management Service anytime after installation.
T he License Management Service collects this information:
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License serial numbers
License server GUID
Licenses used count
Feature name
Product versions

T he WMI service provides access to Citrix Licensing WMI classes. T here's a namespace (ROOT \CitrixLicensing) with a few
classes (notably, Cit rix_GT _License_P ool) that gives license usage and availability counts. Querying the License Server
too often (more than every 15 minutes) might impact performance negatively.
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Types of licenses
Jun 26, 20 17

Your product uses one of the following types of licenses (some products allow you to select more than one type). Ensure
that you are aware of the types of licenses your company purchased and how they are consumed so you don't run out of
licenses. T he license types are:

With a minimum of XenDesktop 5 Service Pack 1 and XenApp 6.5 or later: T he license server can assign licenses to a user or
a device and monitor license consumption. When assigned to a user, the license allows access from an unlimited number of
devices. When assigned to a device, the license allows access from the device by an unlimited number of users.
A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of XenDesktop.
Use this type of license for shared devices, such as a classroom or hospital.
A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the
user to connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook,
smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently.
When users or devices connect to an application or desktop, they consume a license for the 90-day license assignment
period. T he assignment period begins when a connection is made. T he period is renewed to the full 90 days during the life
of the connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If
you have to end a license assignment manually before the 90-day period elapses, use the udadmin command-line tool. For
example, an employee consuming a user license leaves the company.
Opt imizat ion
Using the optimization process, the License Server determines how to minimize consumption based on licenses in use and
connections to the License Server. T he license server optimizes every ﬁve seconds until there are 5000 unique connections.
At 5000 unique connections, optimization occurs every ﬁve minutes. Optimization might delay status information until the
next optimization impacting when license usage statistics are updated in various consoles.
Examples of unique connections - Optimization is not consumption and these examples show when optimization occurs.
Optimization occurs every ﬁve seconds for 1-4999 uses and every ﬁve minutes for 5000 or more uses.
700 users * 1 device each = 700 (optimize every 5 seconds)
5000 users * 1 device each = 5000 (optimize every ﬁve minutes)
5000 devices * 1 user each = 5000 (optimize every ﬁve minutes)
2500 users * 2 devices each = 5000 (optimize every ﬁve minutes)

Note
If you have a large deployment, optimization can be CPU intensive depending on the number of unique connections. We
recommend using machines with multiple cores.

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.27

License overdraft is included in all user/device, per user, and per device licenses. When you purchase user/device licenses, you
receive a 10% overdraft. T he overdraft becomes available after you allocate all your purchased and evaluation licenses.
Overdraft usage is reported in Studio and the License Administration Console. If you routinely use overdraft licenses, we
recommend that you purchase more licenses to maintain compliance.
Example:
You purchase 1000 user/device licenses and get 10% overdraft. You actually have 1100 user/device licenses to use.
If you go over 1100, a 15-day supplemental grace period starts. For more information on supplemental grace period, see
Supplemental grace period.

T his type of license is not tied to a speciﬁc user. When a user starts a product, the product requests the license and it's
checked out to the speciﬁc computer or device that the user is using. When the user logs off or disconnects from the
session, the license is checked back in and is available for another user. Using this logic, keep the following scenarios in mind:
Multiple sessions at different computers use multiple licenses. Each time a user starts a Citrix session from a different
computer or device, a license is checked out until the user closes the session at that computer or device. At that point,
the license is checked back in. For example, a user starts a session from one computer and then starts another from
another computer (before closing the first session), two licenses are checked out.
License servers do not communicate with each other. If you run multiple license servers, you might consume more than
one license (for example, with load balancing). If you are using load balancing, Citrix recommends that the product servers
point to the same license server.
Different editions consume different licenses. If a user connects to an application published on a computer running
Advanced edition, and then uses the same client to connect to an application published on a computer running
Enterprise edition, two licenses are consumed.
Only one license is consumed. A user makes multiple connections from a single device to different product servers
configured as the same edition and pointing to the same license server.
A user connects from a single device to two product servers that are the same edition but different versions. One or two
licenses might be consumed based on the order in which the user makes the connections. For example, the two servers
are XenApp 6.0 and XenApp 6.5 (though this example applies to nearly all Citrix products and versions):
T he user connects to XenApp 6.0 first - T wo licenses might be consumed - An older license first and then a newer
license.
T he user connects to XenApp 6.5 first - Only one license is consumed.
RDP connections consume a license (RDP connections to a console do not consume a license).

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the
user to connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook,
smartphone, or thin client. A licensed user can connect to multiple instances of XenDesktop concurrently. A licensed user
can connect to multiple instances of a product concurrently. When users connect to an application or desktop, they
consume a license for the 90-day license assignment period. T he assignment period begins when a connection is made. T he
period is renewed to the full 90 days during the life of the connection. Expiration (allowing reassignment) is 90 days after
the last connection ends (logs off or disconnects). If you have to end a license assignment manually before the 90-day
period elapses, use the udadmin command-line tool. For example, an employee consuming a user license leaves the
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company.

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of a product.
Use this type of license for shared devices, such as classroom or hospital. It allows an unlimited number of users per device.
When devices connect to an application or desktop, they consume a license for the 90-day license assignment period. T he
assignment period begins when a connection is made. T he period is renewed to the full 90 days during the life of the
connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If you
have to end a license assignment manually before the 90-day period elapses, use the udadmin command-line tool. For
example, an employee consuming a user license leaves the company.

Licenses are consumed per CPU socket used by a CPU and cores are not counted. For example, if a computer having two
CPU sockets has only one CPU, only one license is used. In another example, if that same computer with two sockets has
two CPUs, each with a quad core, only two licenses are used.

When a product requests a license, it is checked out to the user until a preconﬁgured period expires. T his type of check-out
is not tied to a computer or device. After the license is checked out, the user can run multiple sessions on different
computers without checking out more licenses.
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Get started, install, and conﬁgure
Aug 14 , 20 17

T his article contains the following information:
Ensure that you have the latest license server
Security considerations
Firewall considerations
Install licensing components for Windows
Use the command line to disable or enable the License Management Service
Import and conﬁgure the License Server VPX
Obtain your license ﬁles
Disable domain name truncation on Windows
Disable domain name truncation on the Citrix License Server VPX
Move license ﬁles from an older License Server VPX version
Conﬁgure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program (CEIP), and Call
Home
We recommend that you upgrade the license server to the latest version when you upgrade or install new Citrix products.
New license servers are backward compatible and support older products and license ﬁles. New products often require the
newest license server to check out licenses correctly.
To see the new features in this release, go to What's new.
Licensing your product includes the following steps:
1. Ensure that you have the latest license server version.
2. Verify system requirements.
3. Install licensing.
4. Obtain license files from My Account or if you have a license code, use Citrix Licensing Manager.
5. Install your Citrix product (or, if already installed, restart the Citrix products for the new licenses to be recognized)
6. Configure product-side licensing communication settings that were not set during product installation, if applicable. T his
configuration includes setting the correct product-edition in the product. Details about these settings are covered in the
product documentation.
Ensure that the product-side edition setting correctly matches the licenses you have purchased. For example, if you
purchased Platinum edition licenses, ensure that the edition setting in the product indicates Platinum-not Enterprise or
Advanced.

Important
The License Server does not require domain membership. You can install the License Server in a workgroup and still perform all licensing functions on
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behalf of Citrix products. To manage the License Administration Console or the Citrix Licensing Manager users having Active Directory users or groups,
the users must be part of a domain. Otherwise, use local Windows users.

For an overview of the licensing components and process, see Technical overview and Licensing components.

When upgrading or inst alling new Cit rix product s, always have t he lat est license server. T he new license server is
backward compatible and supports older products and license ﬁles. However, new products require the newest license
server to check out licenses correctly. You can install or upgrade the latest version from the product media.
Note: Citrix does not provide hotfixes for license server components and does not support older license servers with newer
products. T he latest versions of the license server often contain resolutions to issues appearing in earlier versions.

To ﬁnd your license server version number
If you are unsure if your license server version is current, you can verify it by comparing your version with the number on the
Downloads site.
On a license server with the License Administration Console:
1. F or windows: Start the License Administration Console from the programs menu: Citrix > License Administration
Console.
F or License Server VP X and remot e syst ems: Open a web browser and go to https://License Server
Name:secureWebPort.
2. Click Administration and select the System Information tab. See the release version in the information list.

We recommend that you upgrade the license server to the latest version when you upgrade or install new Citrix products.
New license servers are backward compatible and support older products and license ﬁles. Each time a new license server is
released, it might contain better security features than in previous versions.
We also recommend the following security considerations when you conﬁgure your environment or use the Licensing
Administration Console.
Configure the license server environment so that only authorized administrators on a trusted network are permitted to
access the Licensing Administration Console port. You achieve this outcome with an appropriately configured network or
host-based firewall.
When using the Licensing Administration Console, avoid visiting untrusted websites or clicking untrusted URLs.

Determine if you require a ﬁrewall between the license server and any product servers before installing licensing. Firewall
considerations can impact where you install the license server.
T he License Server VPX has default ports enabled. To change ports, use the Linux iptables command.
If you have hardware ﬁrewalls in your environment, you must create the necessary rules manually.
If there is a firewall between your product and the license server, configure port numbers. T his configuration process
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entails:
Determining which port numbers to change. You can change port numbers during the installation process or afterward.
Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic can flow. For Windows
Server 2008, the license server Version 11.5 or later configures the built-in firewall automatically.
Changing the product-side settings. Your Citrix product must be configured with the same port numbers as in the License
Administration Console. If you do not change the port number referenced in the product, the product cannot contact
the license server. You can change the product-side settings during and after installation of the product. See your
product documentation for information about these settings.

You can install licensing components on a separate, dedicated server or on a server they share with another application.
Alternatively, you can use a web or application server. However, the locations mentioned below are less resource intensive.
If you are running fewer than 50 servers or 10,000 licenses, you can install the License Server on the same server as your
product. To determine if relocation of the License Server to another system is necessary, monitor CPU and memory load
(lmadmin.exe and CIT RIX.exe).

Important
Use the new CitrixLicensing.exe ﬁle for all future installations, except for Active Directory deployments. In that case, use the .msi.
Ensure that both .exe and .msi ﬁles are present for the installation.

Inst all t he License Server f or Windows and console using t he graphical int erf ace
1. Download the License Server from citrix.com and start the License Server installer, CitrixLicensing.exe, as an administrator
or a member of the administrators group.
2. Follow the installer graphical interface to accept the destination folder.
Licensing components are installed in C:\Program Files\Citrix\Licensing on a 32-bit computer and C:\Program Files
(x86)\Citrix\Licensing on a 64-bit computer.
3. On the Conf igure page, accept or change the default port numbers used by licensing components. Choose whether to
allow the installer to configure the Windows Firewall exception. If needed, you can change the port numbers after
the installation. If you choose to finish the installation without configuring the License Server, restart the
CitrixLicensing.exe installer. You can also use the License Server Configuration tool to configure the settings after the
installation. Open the configuration tool from: C:\Program
Files\Citrix\Licensing\LS\resource\Licensing.Configuration.T ool.exe.
License server port number is 27000
Vendor daemon port number is 7279
Management console web port is 8082
Web Services for Licensing port is 8083
4. T he License Server adds the default License Administration Console administrator based on how you are logged on. If
you are in a domain, the License Server adds the installing user (domain\user) as a default License Administration Console
administrator. If you are a local Windows user, the License Server adds the installing user (computer\user) as a default
License Administration Console administrator. T he BUILT IN\administrator group, which allows any administrator to
manage licensing, is added by default. You can remove BUILT IN\administrators to restrict licensing to specified users. Any
user that has access to managing the License Administration Console can also manage the Citrix Licensing Manager.
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5. Choose to start the License Administration Console or the Citrix Licensing Manager and whether to join the Citrix
Customer Experience Improvement Program.
If you don't choose the Citrix Licensing Manager, or a license from your product administration console, you can still get
your licenses. Go to the citrix.com to obtain the license ﬁles for your Citrix products. T his procedure is detailed in "Obtain
your license ﬁles" below.
Use t he Windows command line t o inst all licensing
When using the CitrixLicensing.exe command to install licensing, set properties by adding Property=value on the command
line anywhere except between an option and its argument.
Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges,
choose St art , right-click Command P rompt , and choose Run as administ rat or.
Not e: T he Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you
are a Citrix Service Provider, you cannot disable CEIP or Call Home.
T he following sample command line installs licensing in silent mode. Add the properties you want to set.
Type the command in one line without returns. T he following example shows multiple lines due to space limitations.
Cit rixLicensing.exe /quiet /l inst all.log INST ALLDIR= inst alldirect ory WSLP ORT = port _number
LSP ORT = port _number VDP ORT = port _number MCP ORT = port _number CEIP OP T IN= value
Where:
/quiet specifies a silent (quiet) installation.
/l specifies the log file location
INST ALLDIR is the location where the License Server executable is stored. Optional parameter. T he default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.
WSLPORT is the port number used for the Web Services for Licensing. Optional parameter. T he default is 8083.
LSPORT is the port number used for the License Server. Optional parameter. T he default is 27000.
VDPORT is the port number used for the vendor daemon. Optional parameter. T he default is 7279.
MCPORT is the port number used for the console. Optional parameter. T he default is 8082.
CEIPOPT IN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. T he default is ANON .
DIAG - Call Home
ANON - CEIP
NONE
You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.
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You can also change the choice made at installation by editing the CIT RIX.opt ﬁle:
#CIT RIX CEIP value
Where value is DIAG, ANON, or NONE
Using t he command line t o inst all licensing f or an Act ive Direct ory deployment
When using the msiexec command to install licensing, set properties by adding Property="value" on the command line
anywhere except between an option and its argument. Clustering is not supported in the .msi.
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Not e: Ensure that you run the command line with administrator privileges. To start the command prompt with elevated
privileges, choose St art , right-click Command P rompt , and choose Run as administ rat or.
T he following sample command line installs licensing in silent mode and creates a log ﬁle to capture information about this
operation. Add the properties you want to set after the switches.
Type the command in one line without returns. T he following example shows multiple lines due to space limitations.
msiexec /I ct x_licensing.msi /l*v inst all.log /qn INST ALLDIR= inst alldirect ory LICSERVERP ORT = port _number
VENDORDAEMONP ORT = port _number MNGMT CONSOLEWEBP ORT = port _number
WEBSERVICELICENSINGP ORT = port _number CEIP OP T IN= value
Where:
/l*v is the location of the setup log. Optional parameter.
/qn specifies a silent (quiet) installation.
INST ALLDIR is the location where the License Server executable is stored. Optional parameter. T he default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.
LICSERVERPORT is the port number used for the License Server. Optional parameter. T he default is 27000.
VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter. T he default is 7279.
MNGMT CONSOLEWEBPORT is the port number used for the console. Optional parameter. T he default is 8082.
WEBSERVICELICENSINGPORT is the port number used for the Citrix Licensing Manager. Optional parameter. T he
default is 8083.
CEIPOPT IN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. T he default is ANON .
DIAG - Call Home
ANON - CEIP
NONE
You can change the CEIP and Call Home choice using the Citrix Licensing Manager.
You also can change the choice made at installation by editing the CIT RIX.opt ﬁle:
#CIT RIX CEIP value
Where value is DIAG, ANON, or NONE

T he License Management Service operates automatically within the License Server and allows for license management and
support. We recommend using the License Management Service for management of your license environment, but you can
disable it any time after installation. For more information, see "Citrix License Management Service" in Technical overview.
Syntax:
ct x_license_management _service.exe (-enable |-disable |-query )
Where:
-enable enables license management. T he ﬁrst upload to Citrix occurs seven days after you install the License Server.
-disable disables license management. We recommend that you use the License Management Service to manage your
licensing environment.
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-query displays the current conﬁguration.

T he Citrix License Server VPX is distributed as a virtual machine system conﬁgured in .xva format.
To import License Server VP X using XenCent er
1. Open XenCenter, click the server on which to import the License Server VPX, and select Import .
2. Browse to the location of your package and choose the .xva package.
3. Choose a Home Server for your virtual machine. T his Home Server is the server on which the virtual machine starts
automatically. Alternately, you can click a XenServer pool and the virtual machine automatically starts on the most
suitable host in that pool.
4. Choose a storage repository for the virtual disk. T he repository must have a minimum of 8 GB of free space.
5. Define network interfaces. T he License Server VPX communicates on a single virtual NIC. Choose a network that is
accessible to the Citrix Servers to which you want to provide license services.
After you import the virtual machine, it appears inside your XenCenter management console. You can restart the virtual
appliance in XenServer by right-clicking on its name and choosing St art .
Conﬁgure t he License Server VP X f or ﬁrst use
After importing the License Server VPX, you have a fully functional Citrix License Server on your XenServer pool. T he ﬁrst
time you start the License Server, a set up wizard opens to conﬁgure networking.
1. After the wizard opens, create a strong root password for administrators.
2. Specify a hostname for the License Server VPX.
Not e: Most Citrix license ﬁles are tied to the case-sensitive hostname of your License Server.
3. Specify a domain for the License Server VPX.
4. Specify whether to use DHCP as your network type. Choose y to obtain network information automatically. Otherwise,
choose n, and type the required network information.
5. Specify a License Administration Console user name and password for the licensing service.
6. Choose whether to enable the Customer Experience Improvement Program and Call Home. For more information, see
About the Citrix Customer Experience Improvement Program (CEIP).
Conﬁgure licenses from a web-based interface, available on port 8082.
If you make a conﬁguration error, log on to the appliance as root with the password you speciﬁed. Type the command
reset set t ings.sh or reset _ceip.sh to rerun the set up wizard.
reset set t ings.sh command
resetsettings.sh provides the option to retain or delete historical data ﬁles while resetting the Licensing Server VPX
conﬁguration. You can fully reset the conﬁguration by deleting all historical data collected until that time or partially reset
the conﬁguration by retaining the historical data.
As root , run the following script and make your choices:
# reset set t ings.sh
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reset _ceip.sh command
reset_ceip.sh provides the option to reset the Customer Experience Improvement Program (CEIP) options you chose during
the original conﬁguration. T his command resets only the CEIP settings and retains all other settings.
On VPX, do not modify the CIT RIX.opt ﬁle. As root, run the following script and make your choice of CEIP [1.DIAG 2.ANON
3. NONE].
#reset _ceip.sh
Export t he dat abase f or use in a dif f erent License Server VP X
Use the migrat e_hist orical_dat a.sh script to migrate the historical data to a newer Licensing Server VPX. T he script
provides options to back up and restore historical data.
Run this script as root .
T his example procedure migrates the data from VP X_O to VP X_N .
1. Run the command # migrat e_hist orical_dat a.sh -b on VP X_O to create a backup file /t mp/hist orical_dat a.t ar.
2. When VP X_N is running, copy or move the /t mp/hist orical_dat a.t ar file to VP X_N using any file transfer protocol.
For example, scp .
3. Run the # migrat e_hist orical_dat a.sh -r / directory command on VP X_N to restore the data. Where directory is the
directory in which historical_data.tar resides.

After you install the licensing components, you are ready to obtain your license ﬁles.
You can obtain your license ﬁles in several ways:
Studio in XenApp and XenDesktop. For more information, see Licensing in the XenApp and XenDesktop documentation.
Citrix Licensing Manager.
License Administration Console.
citrix.com.
Before going to the Citrix website, you need the following information at hand:
T he license code. Find this code: at My Account on citrix.com, in an email you receive from Citrix, or from the
Subscription Advantage Management-Renewal-Information system (SAMRI).
Your user ID and password for My Account. You can register for this password on My Account.
Not e: If you cannot locate these items, contact Citrix Customer Service.
T he Host ID of t he server on which you inst alled t he licensing component s. T he entry field for this name is
case-sensitive, so ensure that you copy the name exactly as it appears on the computer.
You can ﬁnd the license server host name and MAC address (Ethernet) in the License Administration Console in the
Administration area on the System Information tab. You can also run the hostnamecommand at a command prompt on
the license server.
How many licenses you want t o include in t he license f ile. You do not have to download all the licenses you are
entitled to at once. For example, if your company purchases 100 licenses, you can allocate and download only 50 now.
Later, you can allocate the rest in another license file. You can have more than one license file.
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Inst all licenses wit h t he Cit rix Licensing Manager builds 21103 and 20104
Not available in License Server VPX.
Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download
licenses:
After you click Allocate and Download, you cannot cancel it. If the Allocate and Download fails, use My Account at
citrix.com.
T he Citrix Licensing Manager allocates only retail licenses (no evaluation or demo licenses) and doesn't support
redownloading or reallocating of license files. You can return licenses on citrix.com and use the Citrix Licensing Manager
to allocate them again. For redownloading, use My Account .
If you rename the license server, you must reallocate any license files allocated under the old license server name. For
more information about reallocating files, see Reallocate license files.
T he Citrix Licensing Manger gives you the option of choosing how to obtain your licenses:
Use license access code
Use downloaded license f ile - Build 21103 displays inf ormat ion about t he licenses when you use t he
license access code and download license f ile met hods.
In the St art menu, click All P rograms > Cit rix > Cit rix Licensing Manager or from a remote
machine, ht t ps:// licenseservername :8083 .
If you choose Use license access code:
1. Select Use license access code and type the license access code (which is supplied in an email from Citrix) and choose
Display Licenses . Your license entitlements display and you can choose which licenses and the quantity to install.
2. Select a product from the displayed list, type the number of entitlements to install, and choose Inst all. T o select more
than one product, choose a product, click Install, choose the next product, click Install, and so on. T hey are processed in
order. After you install all the licenses for a specific license access code, you cannot use that license access code again. If
you must perform more transactions with that code, log on to My Account .
3. T o display the newly downloaded licenses, refresh the License Administration Console.
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If you choose Use downloaded license ﬁle:
1. Select Use downloaded license f ile , choose a file, and check the check box if you want to replace and older file with
the same name. If you are using build 21103, the Citrix Licensing Manager displays information about the licenses.
2. If your license file is successfully uploaded to the License Server, a message displays. T o display the newly downloaded
licenses, refresh the License Administration Console.
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Obt ain licenses using t he Cit rix Licensing Manager build 19005
Not available in License Server VPX.
Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download
licenses:
After you select Allocate and Download, you cannot cancel it. If the Allocate and Download fails, use My Account at
citrix.com.
T he Citrix Licensing Manager allocates only retail licenses (no evaluation or demo licenses) and doesn't support
redownloading or reallocating of license files. For those features, use My Account.
If you rename the license server, you must reallocate any license files allocated under the old license server name. For
more information about reallocating files, see Reallocate license files.
1. In the St art menu, select All P rograms > Cit rix > Cit rix Licensing Manager or from a remote
machine, ht t ps:// licenseservername :8083 .
2. If you want to change the port or language, click the Set t ings icon on the menu bar at the top of the page. Make
changes and click Save .
3. Select Allocat e Licenses , type the license access code (which is supplied in an email from Citrix) and click Display
Licenses .
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4. Select a product from the displayed list and click Allocat e and Download . T o select more than one product, choose a
product, click Allocat e and Download , choose the next product, click Allocat e and Download , and so on. T hey are
processed in order. After you allocate and download all the licenses for a specific license access code, you cannot use
that license access code again. If you must perform more transactions using that code, log on to My Account .
5. T o display the newly downloaded licenses, refresh the License Administration Console.
Obt ain license ﬁles wit h t he License Administ rat ion Console
1. From a web browser, go to https://ls:8083.
2. Click Administ rat ion and Vendor Daemon Conf igurat ion .
3. Click Import License .
4. Click the cit rix.com link.
5. On the My Account page, type your user ID and password.
6. Select All Licensing T ools .
7. From the main menu, select Allocat e .
8. Follow the process to allocate and generate your file.
9. Select the licenses you want to download, click Download , and save the file to and save the file to a temporary
directory.
10. In the License Administration Console on the Import License F ile page, browse to the license file.
11. If you copied the file directly to the MyFiles directory, or if a file having the same name exists on the License Server,
select Overwrit e License F ile on License Server.
12. Click Import License .
13. Click Vendor Daemon Conf igurat ion and click Administ er in the Citrix vendor daemon line.
14. Click Reread License F iles to allow the license server to recognize the new file.
Users can begin using these licenses when the License Server reads the licenses.
Obt ain license ﬁles manually
1. From a web browser, go to http://www.citrix.com.
2. Click My Account and type your user ID and password.
3. Select All Licensing T ools .
4. From the main menu, select Allocat e .
5. Follow the process to allocate and generate your file.
6. Select the licenses you want to download, choose Download , and save the file to a directory.
7. At the license server, copy the license file from the directory where it was saved to the myfiles directory.
C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer
C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer
/opt/citrix/licensing/myfiles for License Server VPX
T ip: Ensure that the license ﬁle retains the .lic ﬁle name extension. Some copy processes do not recognize a ﬁle type for
that extension and add a ".txt" ﬁle name extension during the copy. License ﬁles that have the wrong ﬁle name extension
cannot be imported.
1. At a command prompt, navigate to:
C:\Program Files\Citrix\Licensing\LS on a 32-bit computer
C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer
/opt/citrix/licensing/LS for License Server VPX
And type the following command: lmreread -c @ localhost -all

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.41

Warning
Editing the registry incorrectly can cause serious problems that might require you to reinstall your operating system. Citrix cannot
guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be
sure to back up the registry before you edit it.

If you are hosting multiple tenants on the same License Server, ensure that the License Server does not truncate
@domain.com. T he License Server detects Citrix Service Provider licenses and enables this functionality.
1. Locate the registry key:
For 32-bit machines: HKLM\Software\citrix\licenseserver
For 64-bit machines: HKLM\Software\Wow6432Node\citrix\licenseserver
Name: UDUseDomain
2. Set the registry key to 1.
Dat a

Descript ion

0

T he domain field is truncated. (default)

1

T he domain field is not truncated.

T he License Server detects Citrix Service Provider licenses and enables this functionality.
1. On the command line, go to the /opt /cit rix/licensing/LS/conf /ud_set t ings.conf file.
2. Using the vi editor, set CT X_UD_USERDOMAIN= 1.
3. Restart the License Server VPX or the Citrix Licensing daemon.
Set t ing

Descript ion

CT X_UD_USERDOMAIN=1

Use user domain from user profile. Disables domain name truncation.

CT X_UD_USERDOMAIN=0

Do not use user domain from user profile. (default)

T his procedure moves only the license ﬁles. Reconﬁgure all the users on the new License Server. Ensure that the license ﬁles
that you move have the correct ownership and permissions.
1. Back up the license files from the old Citrix License Server VPX to a network share.
All the *.lic license files from: /opt /cit rix/licensing/myf iles except cit rix_st art up.lic
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2. Close the old License Server
3. Spin up the new Citrix License Server VPX using the same binding as the older one.
T he binding might be a MAC address or hostname or IP Address specified in the SERVER line of the license files.
4. Restore the backed-up license files from the Network Share to the new License Server. Restore the files to:
/opt /cit rix/licensing/myf iles with the file ownership as ct xlsuser:lmadmin (user:group) and permission as 64 4 .
5. Run this command as ct xlsuser: /opt /cit rix/licensing/LS/lmreread -c @ localhost

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you conﬁgure a proxy server, requests to
download licenses and upload Call Home data are sent through a proxy server.

Important
Citrix Licensing components requiring outward bound web communications can inherit network proxy settings using Windows
automatic proxy detection. We do not support authenticated proxies. For more information, see WinHT T P AutoProxy Functions.

Conﬁgure a proxy server manually
1. Edit the SimpleLicenseServiceConf ig.xml file, which is in the <citrix Licensing>\WebServicesForLicensing directory.
2. Add a line of xml to the file in the format <Proxy>proxy server name:port number</Proxy>
Import ant : T he .xml tags are case-sensitive.
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<Configurations>

<EncoreConfiguration>

<SamplingPeriod>15</SamplingPeriod>

<RetentionTime>180</RetentionTime>

<Enabled>true</Enabled>

</EncoreConfiguration>

<Proxy>10.211.55.5:808</Proxy>

</Configurations>
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Manually install a certiﬁcate used by the Citrix
Licensing Manager and Web Services for Licensing
May 22, 20 17

Note
Use this procedure if you are a Director or Studio administrator who doesn't want to use the self-signed certiﬁcate that is generated
during installation.

To install a certiﬁcate, there are three steps:
1. Obtain a .pfx file, which contains the certificate and private key. You can use one of two methods to obtain the .pfx file.
2. Extract the certificate and private key from the .pfx file.
3. Install the certificate and private key on to the License Server.

Log on to a server in the domain, open the MMC, and follow these steps:
1. Create a directory c:\ls_cert to hold the exported .pfx file.
2. Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer account > Local computer.
3. In the left pane under Certificates, right-click Personal and choose All T asks > Request New Certificate, and then click
Next.
4. In the Certificate Enrollment Policy wizard, choose Active Directory Enrollment Policy, and click Next. Select the check
box next to Computer, and select Details to the right.
5. Select Properties and on the General tab, type a friendly name and description.
6. On the Subject tab, under Subject T ype, choose Common name from the T ype drop-down menu. T ype a friendly name in
the text box, click Add, and then click Apply.
7. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment to the
Selected options box.
8. On the Extended Key Usage drop-down menu, add Server Authentication and Client Authentication to the Selected
options box.
9. On the Private Key tab and under the Key options drop-down menu, ensure that the Key size is 2048. Select the Key
Exportable check box, and then click Apply.
10. On the Certification Authority tab, ensure that the CA check box is selected, and click OK > Enroll > Finish.
11. In the Certificates console, select Personal > Certificates, click the certificate you built. Select All T asks > Export > Next,
and select the Yes, Export the Private Key radio button and Next.
12. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all certificates, click Next, create
a password, and click Next.
13. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to finish.

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.45

T hese steps might vary based on your Certiﬁcate Authority.
1. Log on to the License Server, open the MMC, and follow these steps:
1. Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer account > Local
computer.
2. In the left pane under Certificates, right-click Personal and choose All T asks > Advance Operations > Create Custom
Request, and click Next.
3. In the Cert if icat e Enrollment P olicy wizard, choose P roceed wit hout enrollment policy under Cust om
Request , and click Next .
4. On the Custom request screen, choose (No template) CNG key from the drop-down menu and PKCS#10 for the
Request format, and click Next.
5. On the Certificate Information screen, choose Details and click Properties.
6. On the General tab, type a friendly name and description.
7. On the Subject tab, under Subject name, choose Common name and type a value in the text box.
8. On the Extensions tab, choose Key usage from the drop-down menu, add Digital signature and Key encipherment.
9. On the Extensions tab, choose Enhanced Key usage from the drop-down menu, add Server Authentication and Client
Authentication.
10. On the Private Key tab, under Crypt ographic Service P rovider, choose RSA, Microsoft Software Key Storage
Provider (the default). From the Key options drop-down menu, ensure that the key size is 2048, select the Key
Export able check box, and then click Apply .
11. Save the file to a .req file, submit the .req file to a Certificate Authority (CA), and save the .cer file.
2. In the MMC, under Cert if icat es , right-click P ersonal and choose All T asks > Import . In the Import wizard, select the
.cer file.
3. Create a directory c:\ls_cert to hold the exported .pfx file.
4. In the Certificates console, select Personal > Certificates, and click the certificate you just imported. Select All T asks >
Export > Next, and select the Yes, Export the Private Key radio button and Next.
5. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all certificates, click Next, create
a password, and then click Next.
6. Click Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to finish.

T his step requires OpenSSL or another tool that allows you to extract the certiﬁcate and private key from a .pfx ﬁle.
Important: T he version of OpenSSL shipped with the License Server does not support extracting certificates and private
keys. For information about downloading OpenSSL, go to www.openssl.org. Citrix recommends installing OpenSSL on a
separate workstation to perform these steps:
1. Navigate to the <openssl directory>\bin folder.
2. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.crt -nokeys
Note: T he License Server uses only the .crt certificate format.
3. T ype the password created during the export process (password).
4. Run openssl pkcs12 -in C:\ls_cert\server.pfx -out server.key -nocerts -nodes
5. T ype the password created during the export process (password).

Windows - Web Services f or Licensing:
1. Copy the server.crt and server.key created above to cd \program files
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(x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.
2. Restart the Citrix Web Services for Licensing service.
Windows - License Administ rat ion Console:
1. Copy the server.crt and server.key created above to c:\Program Files (x86)\Citrix\Licensing\LS\conf.
2. Restart the Citrix Licensing service.
VP X:
1. Copy the server.crt and server.key created above to /opt/citrix/licensing/LS/conf/.
2. et c/init .d/cit rixlicensing st op
3. et c/init .d/cit rixlicensing st art
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Export historical usage data by using the Citrix
Licensing Manager
May 22, 20 17

T he Citrix Licensing Manager stores and exports historical usage reports from the License Server on which the tool is
installed. You can specify a date range for the historical usage data and export it to a CSV ﬁle. T he CSV ﬁle provides daily
usage information including the number of licenses in overdraft.

To export hist orical usage dat a
1. Log on to the Citrix Licensing Manager hosted on the License Server: T ype this URL into a browser on a system having
access to the License Server.
ht t p:// License-Server-Hostname:8083/
2. Using the drop-down menus, select the product and edition, the license model, and the date range (larger the better) to
gather the history.
3. After making your selections, click Export , and the browser download dialog displays.
4. Using the Save drop-down menu, select Save As to save the exported .CSV file.
T he default retention period is 180 days.
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Upgrade
Jun 27, 20 17

Each time you upgrade your Citrix product, also upgrade the Citrix License Server. Each time a new License Server is released,
it might contain better security, fixes to known issues, and so on. Sometimes, new versions of the Citrix product are not
compatible with older versions of the License Server.
Note: New versions of the License Server are compatible with older versions of the product and old licenses.
Current Citrix Subscription Advantage members are eligible to version upgrade to the latest release of Citrix products and
upgrade existing licenses to the license system used by these products.
Version upgrade means the movement from any previous version of a product to the newest version of the product. For
example, moving from XenDesktop 5.6 to XenDesktop 7.x.
Edition upgrade means the purchase of a higher edition level of a product. For example, you now have Enterprise Edition
and you purchase an upgrade to Platinum Edition.

Warning
Upgrades are not supported for License Server VPX. See Move license ﬁles from an older License Server VPX version and Export
historical usage data.

Citrix recommends that you install the newest License Server. T he new License Server is backward compatible and supports
older products and license ﬁles. However, new products require the newest License Server to check out licenses correctly.
You can install or upgrade the latest version from the Citrix website (Downloads page).
Upgrade your licensing components before upgrading your product, if necessary.
Uninstall any versions of Citrix Licensing older than version 11.3 (released in 2007) before installing this version.
Use the new CitrixLicensing.exe ﬁle for all future installations and upgrades, except for Active Directory deployments. In
that case, use the .msi. Ensure that both .exe and .msi ﬁles are present for the installation.
Unsure which version of the License Server you have? See Ensure you have the latest license server.
For information about system requirements, see System requirements.

Important
To avoid the failure of any subsequent License Server upgrades: Ensure that when you installed your License Server, you
successfully conﬁgured it with the post installation License Server Conﬁguration tool or uninstalled your previous License Server.

To upgrade t he License Server:
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Download the license components on the Citrix website (Downloads page), start the License Server installer
(CitrixLicensing.exe) as an administrator, and follow the graphical interface.
To upgrade t he License Server f rom your product media:
If you use the product media for your installation, you might have to enable some functionality by using the Citrix Licensing
Manager after your installation. For example, use the Citrix Licensing Manager to enable Subscription Advantage renewals.
1. From your License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
3. Navigate through the Setup screens to Citrix Licensing and follow the instructions.
To upgrade t he License Server f rom t he command line
Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges,
choose St art , right-click Command P rompt , and choose Run as administ rat or.
Not e: T he Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you
are a Citrix Service Provider, you cannot disable CEIP or Call Home.
You cannot change ports during a command line upgrade.
T he following sample command line installs licensing in silent mode.
Cit rixLicensing.exe /quiet /l inst all.log INST ALLDIR= inst alldirect ory CEIP OP T IN= ANON
/quiet specifies a silent (quiet) installation.
/l specifies the log file location
INST ALLDIR is the location where the License Server executable is stored. Optional parameter. T he default is c:\program
files\citrix licensing or c:\program files (x86)\citrix\licensing.
CEIPOPT IN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call
Home. Optional parameter. T he default is ANON .
DIAG - Call Home
ANON - CEIP
NONE
You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.

To run a higher edition of a Citrix product (for example, XenDesktop Enterprise to Platinum), purchase an upgrade license
and add it to the License Server. Also change the product edition setting in the product user interface. It's best to change
the product edition setting when there are few connections to the affected servers or redirect connections to another
computer. When you change the product edition setting, restart the product server for changes to take effect. See the
product documentation for changing the edition setting. If you add the upgrade license to the License Server before you
set the edition to the new edition, the Citrix product stops accepting new connections.

Note
Licenses from old product editions display on the Dashboard of the License Administration Console even though they are no longer
valid. If you do not remove obsolete or unnecessary license allocations, you might see persistent alerts regarding the Subscription
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Advantage expiration dates of these licenses. You cannot turn off these alerts. T he only impact of leaving obsolete license
allocations on License Servers is that you continue to receive these alerts. If you want to remove the licenses, see Delete License
Files.

To upgrade edition licenses:
1. From a web browser, go to http://www.citrix.com.
2. Click Log In and enter your user ID and password.
3. Select All Licensing T ools.
4. From the main menu, select Upgrade.
5. Follow the site options and instructions for upgrading your product edition licenses.
6. Either download or order new media. An email message provides you with instructions to return to citrix.com to allocate
or receive more feature licenses.
7. Log on to www.citrix.com to allocate your licenses, generate a license file, download the license file to your License
Server, and reread the file.

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you conﬁgure a proxy server, requests to
download licenses and upload Call Home data is sent through a proxy server.
If you are a Citrix Service Provider who requires a proxy, follow this conﬁguration.

Important
Citrix Licensing components requiring outward bound web communications can inherit network proxy settings using Windows
automatic proxy detection. We do not support authenticated proxies. For more information, see WinHT T P AutoProxy Functions.

To conﬁgure a proxy server
1. Edit the SimpleLicenseServiceConf ig.xml file, which is in the <citrix Licensing>\WebServicesForLicensing directory.
2. Add a line of xml to the file in the format <Proxy>proxy server name:port number</Proxy>
Import ant : T he .xml tags are case-sensitive.
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<Configurations>

<EncoreConfiguration>

<SamplingPeriod>15</SamplingPeriod>

<RetentionTime>180</RetentionTime>

<Enabled>true</Enabled>

</EncoreConfiguration>

<Proxy>10.211.55.5:808</Proxy>

</Configurations>
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Manage using License Administration Console
May 22, 20 17

T he License Administration Console lets you manage and monitor your Citrix licenses through a web browser.
Use the Dashboard to:
Monitor licenses, license activity, and alerts
Use the Administration area to:
Administer licenses
Configure console users
Configure alerts
Import licenses
Log license management activities
Secure the console server
View system information
Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the
Administration area requires administration privileges and is password-protected.

To open the License Administration Console on the computer on which it is installed:
From the Start menu, choose All Programs > Citrix > License Administration Console.

Navigate your browser to one of the following URL options:
https://lLicense server name:Web service port
https://Client access point name:Web service port
https://IP:Web service port
Where:
License server name is the name of your license server
Client access point name is the name given to the client access point during cluster configuration
IP is the IP address of the license server
Web service port is the port number for the console web service
T he default web service port for the console is 8082.
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Monitor licenses and alerts
May 22, 20 17

Use the Dashboard to monitor your license activity. T he Dashboard is the default view when you open the License
Administration Console.

T he Dashboard presents a synopsis of your licenses:
Name

Descript ion

Product

Product, edition, and type of license

SA Date

T he Subscription Advantage membership expiration date for the product license

In Use

T he number of licenses currently in use, followed by the total number available for use

(Available)
Expiration

T he date the license expires

License T ype

T he type of license, such as concurrent user or system licenses

Hosts

T he Hosts link appears when licenses are checked out and links to a list of the host names with
licenses in use

Licensing events such as the license server stopping or the expiration of a Subscription Advantage membership trigger
dashboard alerts. You conﬁgure alerts in the Administration area. T he list of displayed alerts is updated when the Dashboard
page is reloaded or refreshed.
Alerts about concurrent licenses are tested and triggered at one-minute intervals. T he "Vendor Daemon Down" alert is
triggered immediately.
T here are two categories of alerts:
Crit ical alert s
Dashboard
Alert

Administ rat ion
Name

T riggering Event

T he vendor
daemon has

Vendor daemon
down

T he license server stops, unexpectedly or purposely stopped by the administrator.

Out of

All the concurrent licenses have been checked out.

stopped
T he
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concurrent
Dashboard
license has
Alert
expired

concurrent
Administ rat ion
licenses
Name

T riggering Event

Licenses for
product_name

Concurrent
license expired

T he license has expired. If the license is not a type of license covered by
Subscription Advantage, there is no deleterious effect from being expired. For

have expired

Subscription
Advantage
membership
expired

example, the startup license and evaluation licenses are always "expired" because
they are not covered by Subscription Advantage. You can ignore this alert unless it
is for a license that shows an expired Subscription Advantage date in the
dashboard.
Subscription
Advantage
membership
expired

T he Subscription Advantage membership for a concurrent license has expired.

Import ant alert s
Name of
Alert

T riggering Event

Concurrent
threshold
exceeded

A percentage (specified by the administrator) of concurrent licenses have been checked out.

Concurrent
license

Some days (specified by the administrator) remain before the concurrent license expires.

expiring
Subscription

Some days (specified by the administrator) remain before the Subscription Advantage membership for a

Advantage

license expires. If the license is not a type of license covered by Subscription Advantage, there is no

membership
expiring

deleterious effect from being expired. For example, the startup license and evaluation licenses are
always "expired" because they are not covered by Subscription Advantage. You can ignore this alert
unless it is for a license that shows an expired Subscription Advantage date in the dashboard.

1. On the Dashboard, click the red X icon to view critical alerts or the orange ! icon to view important alerts.
2. Click items in the list to their details.

Alerts are not cleared automatically when the condition changes. Clear the alert manually to remove it from the list.
Click the X icon next to the alert item.
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Change the default and display language
May 22, 20 17

Administrators can change the default language of the License Administration Console display. T he default applies to all
console users. Available languages include:
Chinese (Simplified)
English
French
German
Japanese
Spanish
Users can set a display language for their session. T he console display reverts to the default language at the end of each
user session.
1. Click Administration and choose the Server Configuration tab.
2. Click the User Interface bar.
3. From the Default Display Language drop-down list, choose a language.

You can customize your user session by changing the console display language. T he console language reverts to the default
when you log off. You can change the display language:
Select the language you want:
When prompted during logon.
Or
By clicking Change Display Language at the bottom left corner of the console
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Security
May 22, 20 17

Steps you can take to secure the License Administration Console and Web Services for Licensing:
Use HT T PS for the console web server communications - HT T PS is the default for new installs. If you are upgrading, you
might need to use HT T PS.
Require users to log on to the Dashboard.
Specify a user session timeout.
Change your console password.

For new installations, the License Server uses HT T PS by default for both the License Administration Console (port 8082)
and for Web Services for Licensing (port 8083). T he web browser uses the License Administration Console and Citrix
Licensing Manager. T he Delivery Controller, Studio, and Director use Web Services for Licensing. For HT T PS, the License
Server selects T LS 1.0, T LS 1.1, or T LS 1.2, as determined by the web browser, Delivery Controller, Studio, or Director.
Conﬁguration of T LS version or T LS cipher suites within the License Server itself is not supported.
If you use HT T PS, you must have a valid server certiﬁcate. We generate a self-signed certiﬁcating during installation, but
you can create your own. For more information, see Manually install a certiﬁcate used by the Citrix Licensing Manager and
Web Services for Licensing.

You can optionally secure the Dashboard by forcing users to enter a password. T he Administration area is passwordprotected for all users.
1. Click Administration and select the Server Configuration tab.
2. Click the User Interface bar.
3. Select Require user to log on to view Dashboard.

You can log out users after a speciﬁed time of inactivity, ensuring they do not leave the console unattended.
1. Click Administration and select the Server Configuration tab.
2. Click the Web Server Configuration bar.
3. For Session T imeout, type the number of minutes that a user can remain inactive before being logged out of the
console. T he maximum value is 99999 (69 days, 10 hours, 39 minutes).

You can change your License Administration Console password at any time.
Not e: T he Windows license server does not support changing Active Directory user and local Windows user passwords.
Active Directory users and local Windows users can change their passwords using their native operating systems. On
Windows, if you log on as a Locally Managed user and then log on, the Change Password link displays at the bottom right
corner.
If you log on as a Windows Active Directory user/admin, the Change Password link does not display at the bottom right
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corner. It doesn't support Active Directory users.
1. In the bottom right corner of the console, click Change P assword . If you do not see the link, it is because you are in
the Dashboard area and you are not required to enter your credentials. Clicking the Administ rat ion option causes the
link to appear.
2. T ype your old password.
3. T ype to enter and confirm your new password.
If you forget your password, contact the console administrator to assign you a new one.
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Change port numbers
May 22, 20 17

Licensing installation sets several port numbers for communications. After installation, you can use the License
Administration Console to change port numbers.
Console Web Server P ort : T he HT T PS T CP/IP port that the web server uses to listen for communication with clients
connecting to the License Administration Console. By default, the port is set to 8082. If you are already using that port
number for another application, you can change it to a range between 1 and 65535. If you are upgrading, you maintain
your previous configuration and might not get HT T PS by default. If you change the port, you must stop and restart the
Citrix Licensing service.
License Server Manager P ort : T his port number is used by the License Server Manager. License Server Manager
handles the initial communication among the products, starts the vendor daemon, and relays check out and check in
requests to the vendor daemon. By default, this port number is 27000.
T ip: You can verify which port number is being used from the System Information tab in the Administration area.
Vendor Daemon P ort : T his port number is used by the Citrix vendor daemon. T he vendor daemon is responsible for the
core operations of the License Server, including license allocation. By default, this port number is 7279. However, if you
have a firewall or if the number is already in use, you might need to change the port number.
T ip: You can verify which port number is being used from the Vendor Daemon Configuration tab in the Administration
area.
T he License Administration Console replaces the License Server Port Utility for changing port numbers. T he License Server
Port Utility was used to change port numbers before this functionality was developed in the License Administration
Console.
Note: T he Linux kernel reserves Ports 1 through 1024. When configuring the VPX ports, use ports above 1024. If you use
SSL, use port 8082, which is open in the firewall. If you select a different port for SSL, reconfigure the firewall in the
iptables.

1. In the top right corner of the console, select Administration.
2. Click the Server Configuration tab.
3. Click the Web Server Configuration bar.
4. In the HT T PS Port field, modify the current port number and click Save.
5. In the host machine operating system, open the Services panel and select the Citrix Licensing service.
6. Restart the Citrix Licensing service.

T his procedure changes the port number used by the License Server Manager (lmadmin.exe).
1. In the top right corner of the console, select Administration.
2. Select the Server Configuration tab.
3. Click the License Server Configuration bar to display the associated options.
4. Select the Use this Port radio button and type the new port number in the adjacent field. Click Save to save the new
port number.
5. Restart the Citrix Licensing service.
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1. In the top right corner of the console, select Administration.
2. Select the Vendor Daemon Configuration tab.
3. Select the Citrix vendor daemon from the table.
4. Under the Vendor Daemon Port, set the new port number.
5. Click Save.
6. Restart the Citrix Licensing service.
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Import license ﬁles
Aug 14 , 20 17

After generating your license ﬁle from citrix.com, you are ready to import it into the license server. A startup license is
imported during the license server installation to allow Citrix products to communicate with the license server.
For information about importing license ﬁles using the Citrix Licensing Manager, see Obtain your license ﬁles.
1. After generating and downloading your license file, copy the file to the computer hosting the license server and console.
T he default locations for storing the license file are:
C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server
C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server
/opt/citrix/licensing/myfiles for License Server VPX
T ip: Ensure that the license file retains the .lic file name extension. Some copy processes do not recognize a file type for
that extension and add a .txt file name extension during the copy. License files that have the wrong file name extension
cannot be imported.
2. F or Windows: Start the License Administration Console from the programs menu: Citrix > License Administration
Console.
F or License Server VP X and remot e syst ems: Open a web browser and go to https://License Server
Name:secureWebPort.
3. Start the console and click Administration.
4. Log on and click the Vendor Daemon Configuration tab.
5. Click Import License.
6. Browse to the license file.
7. If you copied the file directly to MyFiles, or the file name is the same as an existing file, select Overwrite License File on
License Server.
8. Click Import License. T he import process copies the file from its existing location into the MyFiles directory where the
License Server can read it.
9. Click Administer in the Citrix vendor daemon line.
10. Click Reread License Files to allow the License Server to recognize the new file.
Users can begin using these licenses when the License Server reads the licenses.

1. From a web browser, go to http://www.citrix.com.
2. Click My Account and enter your user ID and password.
3. Select All Licensing T ools.
4. From the main menu, select Allocate.
5. Follow the process to allocate and generate your file.
6. Select the licenses you want to download, click Download, and save your license files. You can save the files directly to
the default location. T he default locations where license files are kept are:
C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server
C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server
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/opt/citrix/licensing/myfiles for License Server VPX
7. At a command prompt, navigate to:
C:\Program Files\Citrix\Licensing\LS on a 32-bit computer
C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer
/opt/citrix/licensing/LS for License Server VPX
And type the following command: lmreread -c @localhost -all
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License administration
May 22, 20 17

After you have imported your license ﬁles, the Citrix vendor daemon (CIT RIX) administers them. T he Citrix vendor daemon is
responsible for core operations of the License Server, such as tracking how many licenses are checked out and who has
them. T he vendor daemon can manage all your Citrix license ﬁles and is fully backward compatible with any license ﬁles you
have. Set properties for the vendor daemon on the Vendor Daemon Conﬁguration screen of the console.

Important
You can manage only the Citrix vendor daemon by using this console. We don't support running the Citrix vendor daemon on nonCitrix license servers.

T he Vendor Daemon Conﬁguration screen allows you to import license ﬁles, conﬁgure the vendor daemon, and view logs
about license activity. Only users that have administrator privileges can view this screen.
Click Administer in the vendor daemon summary grid to set these options:
Opt ion

Descript ion

Vendor
Daemon Port
in Use

T he T CP/IP port number that the vendor daemon uses for communication with products.

Stop

Stops the vendor daemon, but leaves the console running. When you stop a vendor daemon, this
button changes to Start. Disabled by default.

Start

Starts the vendor daemon and reads the license files. T his button only appears when the vendor
daemon is stopped. When you start a vendor daemon, this button changes to Stop.

Reread
License Files

Rereads the contents of the license files and the options file.

Report Log
Name

T his option is not functional.

Rotate
Report Logs

T his option is not functional.
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Conﬁgure console users and licensing alerts
May 22, 20 17

T he License Administration Console can use License Administration users, local Windows users and groups, and Active
Directory users and groups. T he Citrix Licensing Manager can use local Windows users and groups and Active Directory users
and groups. T he License Administration Console manages them all. T hese users are not connected to the computer local
users.
T he Active Directory users and groups are part of an Active Directory/network authentication system. To support them,
ensure that the Windows License Server is a member of a Microsoft Active Directory domain and running the License
Administration Console. Windows NT domains are not supported.

Note
T he License Server VPX does not support Active Directory or the Citrix Licensing Manager.

Users are conﬁgured with local roles. All users are created as administrators and can:
View the Dashboard for license activity and alerts.
Change their own password. Active Directory users and groups do not have passwords associated with them. T hey
contact Active Directory to be authorized and follow standard Active Directory user password policies.
Select a console display language.
Change their own password.
Select a console display language.
View system information.
Add and remove users and expire their passwords. You can expire passwords for local users only.
Configure alerts.
Configure the license server.
Configure the vendor daemon.
Stop the license server after you change it.
Configure the administration console.
Configure, and add licenses with, the Citrix Licensing Manager.
Administrators must type user name and password when opening the Administration area. Settings in Server Conﬁguration
allow you to secure the Dashboard by optionally requiring users to log on. If Password Protected Dashboard is enabled, all
users accessing the License Administration Console must log on.
What types of accounts are added at installation
A default administrator account is created during installation of the License Administration Console. Use the administrator
account to ﬁrst log on to the console and then conﬁgure more users.
During installation of the License Administration Console, accounts are added based on machine membership. For
workgroup machine installations, computer\InstallUser and BUILT IN\Administrators are added. For Active Directory
installations, domain\InstallUser and BUILT IN\Administrators are added. You can remove any of these accounts after
installation, but ensure that there is at least one administrator.
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Add locally managed users
1. Click Administration and then the User Conf iguration tab.
2. Click New Users.
3. Select Locally Managed Admin from the drop-down menu.
4. T ype information based on the Role chosen. Required fields are identified with an asterisk (*).
User names are case-sensitive and cannot contain a backslash (\).
5. Optionally select the User must change password on next logon check box to force the user to create a password.

Add local Windows users and domain users and groups
1. Click Administration and then the User Conf iguration tab.
1. If you are adding domain users or groups, click Domain Users/groups.
2. Click New Users.
3. Select a role from the drop-down menu.
4. T ype information based on the Role chosen. Required fields are identified with an asterisk (*).
Users and groups must be created as domain\user (domain can refer to a machine name) or domain\group.
Local Windows users must be created as computer\user.
For domain users, names are converted to upper case and stored. An upper case domain user name (for example,
T EST \HARVEY) can coexist with a lower case local user name (for example, test\harvey). An upper case domain user
cannot coexist with an upper case local user name.

Change a user password f or locally added users
1. On the User Configuration page, click Edit in the line containing the user record.
2. T ype and confirm the new password.
3. Optionally select the User must change password on next logon check box to force the user to change the new
password.

Conﬁgure licensing alerts
Alerts display on the Dashboard and are classiﬁed as critical or important. Administrators can select which alerts appear on
the Dashboard and set the thresholds that trigger them.
1. In the top right corner of the console, click Administration and select the Alert Conf iguration tab.
2. Select the alerts you want to display on the Dashboard, and for the important alerts determine the threshold to trigger
the alert.
3. Click Save.
4. By default, Subscription Advantage membership alerts are also displayed on the Dashboard. T o turn on or off these
alerts:
1. Click Vendor Daemon Conf iguration.
2. Select the Citrix vendor daemon.
3. Select or clear Enable Subscription Advantage membership expiration alerts f or this vendor daemon.
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Improve performance by specifying thread use
May 22, 20 17

Requests come in to the license server through a listener port. An acceptance thread must accept all communication. If the
message is accepted, a receive thread handles it and then a processing thread processes it. T o improve license server
performance when receiving many requests, you can configure the maximum number of receive and processing threads to
use.
When a program initiates an I/O request (an example would be a request to check out a license), it creates and uses a
thread. T he thread maintains the place and data in the program as a reference point. Once the request is complete, the
program can be reentered at the same point. You can have many requests at the same time, depending upon how many
threads are allowed. T his technique is called multithreading.
T he optimal values needed for acceptable license server performance dependent on the hardware, the site configuration,
and the request volume. If you set the limits too high and your hardware cannot support it, it slows down the
communication. If you set the limits too low, it takes longer for the communication to occur. T he system waits until it can
create more threads before it executes incoming requests. T est and evaluate different values to determine the
configuration that meets your site needs. A good starting point for a large-scale deployment might be setting:
Maximum Number of License Server Manager Processing T hreads to 30.
Maximum Number of License Server Manager Receiving T hreads to 15.
T here are two areas where you can specify the thread limits:
License Server
Web server

Set license server thread use
1. In the top right corner of the console, click Administration.
2. Click the Server Conf iguration tab and the License Server Conf iguration bar.
3. Modify the Maximum Number of License Server Manager Processing Threads and Maximum Number of License
Server Manager Receiving Threads fields (up to 999 threads).
4. Restart the Citrix Licensing service.

Set web server thread use
Use this procedure to set the maximum number of threads that the web server for the License Administration Console uses
to process requests. Specify a larger number if you expect many users to access the console simultaneously.
1. In the top right corner of the console, click Administration.
2. Click the Server Conf iguration tab and the Web Server Conf iguration bar.
3. Modify the Maximum Number of Web Server Threads f ield (up to 999 threads).
4. Restart the Citrix Licensing service.
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System information and logs
May 22, 20 17

System inf ormation
You can view system information about the license server and the system running the license server. T he following
information is available by clicking the Administration option in the top right corner of the License Administration Console,
followed by the System Inf ormation tab.
Name

Description

Release Version

T he version of the license server.

License Server
Manager Port
Number in Use

T he port number that the license server uses to communicate with the products.

On Windows, the display is the system name or the terminal server client name (in a terminal server
environment).
Display

On UNIX, the display is the X-Display name or the value returned by the ttyname() (or comparable)
function.

Host Name

T he name of the computer hosting the license server.

Host Domain
Name

T he fully qualified name of the computer hosting the license server.

IPv4 Address

T he IP version 4 address of the computer hosting the license server. T he IPv4 address displays only if
the computer has IPv4 enabled.

IPv6 Address

T he IP version 6 address used to identify the computer hosting the license server. T he IPv6 address
displays only if the computer has IPv6 enabled.

Ethernet
Address

T he Ethernet address (also known as the MAC address) of the computer hosting the license server.

Local Stop
Server Allowed

Displays yes or no. If it is no, you cannot stop the license server using the lmdown utility or the
console. Configure this property using the -allowStopServer command-line option when you run the
license server manager (lmadmin). Disabled by default.

Remote Stop
Server Allowed

Displays yes or no. If it is no, you cannot stop the license server from a remote machine using
lmdown or the console. Disabled by default.
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Logs
Log ﬁles are stored in:
C:\Program Files\Citrix\Licensing\LS\Logs on a 32-bit server
C:\Program Files(x86)\Citrix\Licensing\LS\Logs on a 64-bit server
C:\Program Files (x86)\Citrix\Licensing\WebServicesForLicensing\Logs on a 64-bit server
/opt/citrix/licensing/LS/logs for VPX
Log

File name

Viewable f rom

What it logs

License

lmadmin.log

Server Configuration > Logging

License server, console, and administration

server log
Vendor

activities
citrix.log

daemon log
Access log

Vendor Daemon Configuration >

Licenses and license activities

Vendor Daemon Log
access.log

logs folder

HT T P access events
Note: T his log is used by support personnel for
debugging purposes only.

Web log

web.log

logs folder

Web server information
Note: T his log is used by support personnel for
debugging purposes only.

Some versions of the license server (previous to 11.6.1) included a report log. T he License Administration Console does not
include a report log. Legacy report log ﬁles, are updated only when you relocate the ﬁle reportlog.rl to the logs directory
and update the options ﬁle to control it.
C:\Program Files\Citrix\Licensing\LS\reportlog.rl for Windows
Or
/opt/citrix/licensing/LS/reportlog.rl for License Server VPX

To view and conﬁgure the license server log
1. In the Administration area, on the Server Conf iguration page, click the Logging bar.
2. Click View log f ile.
3. T o change the level of logging, select the type of information to be recorded from the Log Level drop-down list.
Note: Leave this property set to the default setting of Information unless support personnel instructs you to change it
to aid in troubleshooting.

To view the vendor daemon log
T his procedure displays the latest 200 lines of data in the ﬁle. You can view the entire contents of the log (citrix.log) by
opening it directly from:
\\Program Files\Citrix\Licensing\LS\Logs folder for Windows
Or
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/opt/citrix/licensing/LS/logs folder for License Server VPX
1. In the Administration area, on the Vendor Daemon Conf iguration screen, click the Vendor Daemon Log bar.
2. Select View log f ile.

To conﬁgure the vendor daemon log
1. In the Administration area, on the Vendor Daemon Conf iguration page, click the Vendor Daemon Log bar.
2. Select whether to overwrite or append to the log:
Option

Description

Overwrite

When selected, this option overwrites the log when you restart the Citrix Licensing service or the

Vendor

vendor daemon. If the option is clear, the log entries are appended to the end of the file.

Daemon Log
Vendor

We don't recommend changing log location.

Daemon Log
Location
3. Click Save.
4. Click Stop under Vendor Daemon Actions.
5. Click Administer on the Vendor Daemon Conf iguration page and then Start under Vendor Daemon Actions.
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License ﬁles
May 22, 20 17

When you install the license server, a startup license and an options ﬁle are installed automatically. To license your Citrix
products, you add one or more license ﬁles. For information about adding your product licenses, see Obtain your license
ﬁles.
You cannot change the location of license ﬁles on the License Server. License ﬁles must reside in their default location.
Startup license ﬁle
T he startup license ﬁle (citrix_startup.lic) is a text ﬁle that Citrix products use to communicate to the License Server using a
continuous open connection. Every ﬁve minutes the license server and the product send a heartbeat message to each
other to verify that they are mutually communicating. When the product and License Server are exchanging heartbeat
messages, but there is an interruption in the exchange, the product goes into a grace period. A power failure is an example
of an interruption. T he startup license does not affect your license count. Do not edit this ﬁle.
You can control different aspects of your licensing operations and environment by customizing the license ﬁle.
License ﬁle
T he license ﬁle is a text ﬁle containing the following:
Product licensing information
License server name (or other binding identifier)
Subscription Advantage membership renewal date (also known as the Subscription Advantage Expiration date)
License expiration date (if applicable)
Other system information
All this information is encrypted using a digital signature. When you purchase a Citrix product, go to the citrix.com website
to download a license ﬁle. You can have more than one license ﬁle per license server. T he license ﬁle resides in the
C:\Program Files\Citrix\Licensing\MyFiles directory on a 32-bit server
C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server
/opt/citrix/licensing/myfiles directory for License Server VPX
Where the license server references it. T he license server uses this ﬁle to determine whether or not to grant a license to a
Citrix product.
Move license ﬁles to a dif f erent host
You cannot move the license ﬁles that you downloaded for the old license server to a server that has a different hostname
or MAC address. Create license ﬁles that reference the new server name by reallocating them.
See Reallocate license ﬁles for more information.

License ﬁle f ormat

Important
Changes can make license ﬁles unusable. If using Citrix Licensing for Windows 11.6.1 or later, editing license ﬁles is not necessary.
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You can manage licenses and their tasks through the License Administration Console and the My Account site.

Note: You can change the name of the license file, but it must have a .lic extension.
Citrix license ﬁles use the following naming convention: license_FID_XDT -PLT -UD_25-mar-2013.lic.
License ﬁles are composed of lines listing speciﬁc information, such as the server name (SERVER) or quantity of licenses
(INCREMENT ). T hese lines begin by using words denoting their purpose in uppercase letters, such as VENDOR, SERVER,
INCREMENT, USE_SERVER.
T he following sections provide in-depth information about the following elements of license ﬁle syntax: the SERVER line,
VENDOR line, USE_SERVER line, and INCREMENT line. While the term feature is used in the options and license ﬁle syntax,
in this document, the term product license is used whenever possible for clarity.
Example license file displaying numbers corresponding to the explanations following the example:

1 SERVER Line
T he SERVER Line. T he SERVER line specifies the binding identifier (also known as the hostname) of the license server.
Caution: Do not change the binding identifier on the SERVER line. Otherwise, the license file doesn't work.
Syntax
SERVER this_host ether
Or
SERVER this_host HOST NAME=hostname
Parameters

Description

ether

T he MAC address of the appliance on which the license server is running. Do not edit this text string.

hostname

T he name of the computer on which the license server is running. Do not edit this text string.

Example
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SERVER this_host HOST NAME=license_server1

2 VENDOR Line
T he VENDOR line speciﬁes the Citrix vendor daemon name.
Syntax
VENDOR CIT RIX [vendor_daemon_path]
Field

Description

VENDOR CIT RIX

Name of the Citrix vendor daemon. Do not edit this name.

vendor_daemon_path

Path to the executable for the Citrix vendor daemon. Citrix recommends that you do not
change this path.

3 INCREMENT Lines
An INCREMENT line describes the license required to use a product. License ﬁles (*.lic) contain one or more INCREMENT
lines. Each INCREMENT line makes up a user-speciﬁed allocation of product and license (users, connections) counts.
Each increment line contains:
A signature based on the data in that line
T he hostids specified in one or more SERVER lines
Data selected by Citrix
INCREMENT lines use a backslash ( \ ) to wrap long lines of text.
Syntax
INCREMENT feature vendor SA_expiry_date exp_date num_lic \
SIGN=sign [optional_attributes]
Caution: Do not change the six fields after the INCREMENT line keyword. T he fields are required and have a fixed order.
T he following table explains these fields in the order they appear:
Field

Description

feature

T he product license. Do not edit this line.

vendor

Indicates that this license is for a Citrix vendor daemon. Do not edit this line.
Indicates the date until which you are entitled to product version upgrades. If you don't have
a Subscription Advantage membership, or this license isn't a Subscription Advantage license,
the date indicates when you ordered or redeemed the license. Do not edit this line.
Note: If you renewed your Subscription Advantage membership and received an upgrade
license, two dates are listed.
T he first date is the date when the Subscription Advantage membership was originally
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SA_expiry_date

purchased
T he second date is the SA_expiry_date

Example:
INCREMENT MPS_ENT _CCU CIT RIX 2005.0311 2007.0311 permanent 1000 \
See Upgrade Lines for additional information.

Expiration date of license in the format dd-mmm-yyyy, that is, 07-may-2006. Do not edit this

exp_date

line.
Note: If the exp_date ﬁeld contains the text string permanent, the license never expires.

num_lic

Number of concurrent licenses for this product license. Do not edit this line.

SIGN= sign

SIGN= signature to authenticate this INCREMENT line. Do not edit this line.
Strategically turns off speciﬁc licenses based on license feature and signature or
INCREMENT line to be disabled.

SUPERSEDE_SIGN= sign

Example:
SUPERSEDE_SIGN={"CBR_100_SSERVER:0F76 2946 4790 6B67 08E0 65BC 302B E1B6 6ECE
41D6 8AB6 E9C6 FE44 4EB3 9A83 01E4 D405 3E95 74B8 9BC8 7791 BDD3 1385 33F8 9533
95FF A3E4 F461 35B4 251E"}

INCREMENT lines also determine the grouping of licenses in the management console. T hese groups are known as license
pools. T he Citrix vendor daemon creates the license pools based on common attributes, such as product license or version.
When a new pool is created, the console displays and tracks this pool independently from other license pools. When two or
more attributes are different, the Citrix vendor daemon creates a license pool.
Citrix Attributes in INCREMENT Lines
INCREMENT lines can also include more attributes from Citrix. T hese attributes provide information about the license, such
as the date on which it was issued or that the license is an upgrade license.
Caution: Do not change or remove these attributes.
Example

Important items are highlighted in the above example:
T he Product (license feature) appears in blue
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T he Citrix Subscription Advantage expiration date appears in red (Format: YYYY.MMDD)
T he License (user, connection) Count appears in GREEN
Syntax
keyword=value
T he following table describes the Citrix attributes. T he uppercase letters of the attributes indicate that this attribute is not
editable.
Attribute

Description

DUP_GROUP=V

T his attribute allows license sharing for the same client device.

ISSUED=dd-mmm-yyyy

Date issued.

ISSUER="..."

Issuer of the license.

NOT ICE="..."

Your company name.

SN=serial_num

A number that is used to identify INCREMENT lines.

ST ART = dd-mmm-yyyy

T he date from which you can use a license. T he license server cannot use licenses
before their start date.

SUPERSEDE="MPS_ADV_CCU

T his attribute appears in the upgrade license file when you move to a higher product

MPS_ST D_CCU ..."

edition. If this attribute appears, this line supersedes all licenses issued before the date
specified in ISSUED= and they become ineffective.

VENDOR_ST RING="..."

T ext string defined by Citrix.

Optional Attributes in INCREMENT Lines

INCREMENT lines contain several attributes that you can add, edit, or delete. You can add attributes, if desired. For
example, you can insert an asset tag or a purchase order number beside each license in a file. Likewise, you can add
attributes that indicate a specific group of licenses is dedicated for a department in your organization.
Citrix or your Value Added Reseller (VAR) might insert some of these attributes.
Optional attributes are listed in the table that follows. Like the Citrix-specific attributes, the optional attributes have a
keyword=value syntax where keyword is in lowercase. You can tell the difference among optional and required attributes
by the case of the letters: optional attributes have lowercase letters.
Attribute

Description

asset_info= "..."

Additional information you can add for asset management

dist_info= "..."

Additional information provided by the software distributor

user_info= "..."

Additional information provided by the license administrator
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Attribute

Description

vendor_info= "..."

Additional information provided by Citrix

Example of a base license:
INCREMENT CBR_100_SSERVER CIT RIX 2016.1201 permanent 10 \
VENDOR_ST RING=;LT =Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE;SA=1;ODP=0 \
DUP_GROUP=V ISSUED=18-dec-2005 NOT ICE="Citrix" \
SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 06FC \
E1DE B5D5 D793"
Example of a Subscription Advantage Renewal license containing SUPERSEDE_SIGN:
INCREMENT CBR_100_SSERVER CIT RIX 2017.1201 permanent 10 \
VENDOR_ST RING=;LT =Retail;GP=720;MAXBW=2;MLC=0;HA=0;CL=BRSE;SA=1;ODP=0 \
DUP_GROUP=V ISSUED=18-dec-2007 NOT ICE="Citrix" \
SN=100se200seU SUPERSEDE_SIGN={"CBR_100_SSERVER:1B19 C213 7517 \
CC62 756F 864C 9C93 06FC E1DE B5D5 D793"} SIGN="1D5D 869A 40BE \
D4DB 361D 7897 AFA5 FF8B E52A 20BA 5525 01AA F241 6919"
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Reallocate license ﬁles
May 22, 20 17

License ﬁles run only on the license server or hardware appliance that was speciﬁed when they were generated. If you
change the binding identiﬁer of a server or appliance hosting license ﬁles, reallocate license ﬁles so that they match the new
binding identiﬁer.
T he binding identiﬁer is the information in the license ﬁle that identiﬁes the machine where the license ﬁle is hosted. T he
binding identiﬁer is usually the license server hostname, but it can also be a hardware appliance name, Ethernet address
(MAC address), or FQDN.
Situations in which you might need to reallocate a license file:
You rename your license server
You want to move your license files to a server that has a different name
You used some licenses initially to create a test environment and now you want to reuse those licenses on a different
license server
Designating a new binding identiﬁer when you reallocate licenses does not consume more licenses. T he process changes
only the binding identiﬁer for the licenses.

Reallocate license ﬁles by using the License Administration Console
1. From a web browser, go to https://ls:8083.
2. Select Administration and Vendor Daemon Conf iguration.
3. Select Import License.
4. Select the My Account link.
5. On the My Account page, type your user ID and password.
6. Select All Licensing Tools.
7. From the main menu, select Reallocate.
8. Select the check boxes preceding the licenses you want to reallocate, click Continue.
9. Follow the instructions to select the licenses to reallocate in to the new file (and associated with a new license server)
and download the license file.
10. Save the files to a temporary location (remember the file names and location where you downloaded the file; you need
this location).
11. In the License Administration Console on the Import License File page, browse to the license file.
12. If you copied the file directly to MyFiles, or if the file has the name of an existing one, select Overwrite License File on
License Server.
13. Select Import License.
14. Select Vendor Daemon Conf iguration and select Administer in the Citrix vendor daemon line.
15. Select Reread License Files to allow the license server to recognize the new file.

To reallocate license ﬁles without the console
1. From a web browser, go to http://www.citrix.com.
2. Select My Account and type your user ID and password.
3. Select All Licensing Tools.
4. From the main menu, select Reallocate.
5. Select the check box preceding the licenses you want to reallocate, then click Continue.
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6. Follow the instructions to select the licenses to reallocate in to the new file (and associated with a new license server)
and download the license file.
7. Save the file to a temporary folder (remember the file name and location where you downloaded the file; you need this
location).
8. At a command prompt, navigate to the folder and type the following command:
lmreread -c @localhost -all
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Replace (redownload) license ﬁles
May 22, 20 17

Replacement license ﬁles are copies of license ﬁles you previously generated. If you corrupt or remove a license ﬁle, you
might have to download replacement ﬁles. You can select how to redownload the licenses by using the By Host or By
Allocation tabs.

Redownload license ﬁles using the License Administration Console
1. From a web browser, go to https://ls:8083.
2. Select Administration and Vendor Daemon Conf iguration.
3. Select Import License.
4. Select the My Account link.
5. On the My Account page, type your user ID and password.
6. Select All Licensing Tools.
7. From the main menu, select Redownload.
8. Select Select All to select all items on all pages. Check the Page check box to select all items on that page, or check the
check boxes preceding the licenses that you want to download.
9. Select Download and save the files to a temporary folder. Remember the file name and location where you downloaded
the file. You need this location.
10. If you copied the file directly to MyFiles directory, or the file has the name of an existing one, select Overwrite License
File on License Server.
11. Select Import License.
12. Select Vendor Daemon Conf iguration and select Administer in the Citrix vendor daemon line.
13. Select Reread License Files to allow the license server to recognize the new file.

Redownload license ﬁles without the console
1. From a Web browser, go to http://www.citrix.com.
2. Select My Account and enter your user ID and password.
3. From the main menu, select Redownload.
4. Select Select All to select all items on all pages. Check the Page check box to select all items on that page, or check the
check boxes preceding the licenses that you want to download.
5. Select Download and save the file to a temporary location. Remember the file name and location where you
downloaded the file. You need this location.
6. At a command prompt, navigate to the folder and type the following command:
lmreread -c @localhost -all
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Combine license ﬁles
May 22, 20 17

If you are accumulating a lot of license ﬁles on a license server, you can combine the licenses into one license ﬁle. License
ﬁles can accumulate when you:
Purchase additional licenses
Renew your Subscription Advantage membership
T ip: Back up and then delete the old license files from the license server before replacing them with the new files.

To combine ﬁles using the License Administration Console
1. From a Web browser, go to https://ls:8083.
2. Click Administration and Vendor Daemon Conf iguration.
3. Click Import License.
4. Click the My Account link.
5. On the My Account page, enter your user ID and password.
6. Select All Licensing Tools.
7. From the main menu, select Redownload.
8. Use the By Host tab (to automatically combine all specified licenses allocated to a host ID into single line item) and click
Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check
boxes preceding the licenses that you want to download.
9. Click Download and save the files to a temporary folder (remember the name of the file and location where you
downloaded the file; you will need this location).
10. In the License Administration Console on the Import License File page, browse to the license file.
11. If you copied the file directly to the MyFiles directory, or if the file has the same name as an existing one, select
Overwrite License File on License Server.
12. Click Import License.
13. Click Vendor Daemon Conf iguration and click Administer in the Citrix vendor daemon line.
14. Click Reread License Files to allow the license server to recognize the new file.

To combine ﬁles without the console
1. From a Web browser, go to http://www.citrix.com.
2. Click My Account and enter your user ID and password.
3. Select All Licensing Tools.
4. From the main menu, select Redownload.
5. Use the By Host tab (to automatically combine all specified licenses allocated to a host ID into single line item) and click
Select All to select all items on all pages, click the Page check box to select all items on that page, or select the check
boxes preceding the licenses that you want to download.
6. Click Download and save the files to a temporary folder (remember the name of the file and location where you
downloaded the file. You will need this location).
7. At a command prompt, navigate to the folder and type the following command:
lmreread -c @localhost -all
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Delete license ﬁles
May 22, 20 17

When you upgrade your edition (for example, Advanced to Enterprise, or Enterprise to Platinum) you receive new Citrix
product licenses that you can allocate to one or many Citrix License Servers through license ﬁles created at citrix.com.
Rescinded licenses must be removed from license servers within ninety (90) days of new license purchase. Removing the
licenses enables:
License asset management
License compliance
Remove unnecessary alerts from appearing in the management console
Considerations when deleting ﬁles:
Incorrect removal of license files could inadvertently lower the total licenses available.
Place any new license files on the license server prior to deleting any licenses.
Remove a license file only when all INCREMENT lines in the file are obsolete or unnecessary. For example, every
increment line has been replaced with a new license as a result of an upgrade.
If you used the License Administration Console to add license files, you have to update the console UI for any deleted
files.

Important
Never delete the options ﬁle (citrix.opt) or startup license (citrix_startup.lic).

1. At the license server, open the Services panel and stop the Citrix Licensing service.
2. Open Windows Explorer and navigate to where the license files are stored. By default license files are stored in:
C :\Program Files\Citrix\Licensing\MyFiles on a 32-bit server
C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server
/opt/citrix/licensing/myfiles for License Server VPX
3. Back up all license (.lic) files.
4. Using a text editor (Microsoft WordPad is recommended), open each license (.lic) file and identify the obsolete license
feature INCREMENT line(s).
5. Ensure all increment lines are obsolete or unnecessary. See License file format for information about increment lines.
6. Close the file and change the file extension from .lic to .old.
7. In the Services panel, restart the Citrix Licensing service.

To update the License Administration Console UI
If you added license ﬁles with the console, you must update the console UI after removing those ﬁles.
1. Start the console and click Administration.
2. Log on as an administrative user and click the Vendor Daemon Conf iguration tab.
3. Select the Citrix vendor daemon from the list.
4. Edit the contents of License File or Directory to remove any deleted licenses and then save the configuration.
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License administration commands
May 22, 20 17

While the License Administration Console provides an easy method of accessing many licensing features, you can also
perform licensing tasks using commands. You might use license administration commands when performing advanced
operations on the license server that are not available in the console. Such operations include diagnosing check-out
problems using lmdiag.
License administration commands are stored in:
C:\Program Files\Citrix\Licensing\LS on a 32-bit computer
C:\Program Files (x86)\CCitrix\Licensing\LS on a 64-bit computer
/opt/citrix/licensing/LS for License Server VPX

Table of commands
Utility

Description

lmadmin

Provides licensing configuration. Use the License Administration Console for licensing configuration and
administration tasks. Do not use lmadmin.

lmdiag

Diagnoses license check-out problems.

lmdown

Gracefully shuts down the License Manager and Citrix vendor daemons (disabled by default).

lmhostid

Reports the host ID of the server on which Citrix Licensing is running.

lmreread

Causes the License Manager daemon to reread the license file and start the Citrix vendor daemon.

lmstat

Displays the status of a license server.

lmutil

Displays a list of licensing utilities or executes other commands.

lmver

Displays version information for the licensing binaries.

udadmin

Displays all licensed users and devices and deletes specified licensed users and devices. T his command applies
to User/Device licenses only.

Format license commands
Formatting conventions for the license administration commands:
Convention

Description

Bold

A command or switch, such as lmstat.
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Convention
Italic

Description
You need to replace variables with a value; for example, in the expression:
lmstat -clicense_ﬁle_list
Before you run the command you must replace license_ﬁle_list with the names of one or more license
ﬁles.

[square
brackets]

Square brackets around text indicate options that can be added to the command or that text within
the brackets needs to be replaced.

Universal arguments
Valid arguments for most license administration commands:
Argument

Description

-all

Applies the command to all of the license servers on the network.

-c

Lets you specify license file(s) or license server port and host name.
If you specify the path without a license ﬁle name, the command applies to all the license ﬁles in the
directory.
For a local host: -c @localhost
For a remote license server: -c @servername
For a license server in a cluster: -c @clientaccesspointname
For a speciﬁed path: -c path
For the names of one or more license ﬁles: -c license_ﬁle_list
You can enter more than one license ﬁle path by separating each path with a semicolon.
Path names that include spaces must be enclosed in double quotes.

-h

License handle, as reported by lmstat -a. T he license handle is a number used to identify a specific checked
out license.

-help

Displays usage information and exits.

-s [server]

Displays the status of all license files listed on the license server or on all license servers, if server is not
specified.

-verbose

Displays a longer description for all errors found.

Diagnose checkout problems (lmdiag)
lmdiag allows you to diagnose problems when a product cannot check out a license. In particular, you can test if your

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.82

licenses are valid and if the license server is running. When you run this utility, it attempts to check out a license.
You can also use the lmdiag utility to see if a speciﬁc type of license is working. For instance, you can run lmdiag on your
Citrix XenApp server, Advanced edition licenses only by specifying MPS_ADV_CCU as an argument.

Syntax
lmdiag -c license_file_list [-n] [feature[:keyword=value]]
Argument

Description

-c

Diagnoses the specified files. You can also use:-c @localhost or -c @server-name

license_ﬁle_list

-n

Runs in non-interactive mode; lmdiag does not prompt for any input in this mode.

feature

Limits the feedback to the specified feature.

keyword=value

If a license file contains multiple lines for a particular feature, the result is limited to the line
containing the text value. For example:
lmdiag -c @localhost MPS_ENT_CCU:HOSTID=LICSERV01
attempts a checkout on the line with the host ID "LICSERV01."
Keyword is one of the following: VERSION, HOST ID, EXPDAT E, KEY, VENDOR_ST RING, ISSUER

If no feature is speciﬁed, lmdiag operates on all features in the license ﬁles in your list. lmdiag displays information about the
license, then attempts to check out each license. If the check out succeeds, lmdiag indicates success. If the check out fails,
lmdiag gives you the reason for the failure. lmdiag attempts to connect to each TCP/IP port on the license server. It
detects if the port number in the license ﬁle is incorrect. lmdiag lists each TCP/IP port number that is listening, and if -c
license_ﬁle_list is speciﬁed, diagnoses the speciﬁed ﬁles.
lmdiag does not contact the computer running the Citrix product when it attempts to check out licenses. lmdiag indicates
only if there are problems on the license server. T hat is, your product cannot check out licenses because it is pointing to the
wrong license server (for example, a license server that does not have licenses for that product on it), but lmdiag does not
detect this problem. lmdiag reports that it can check out licenses when the Citrix product is pointing to the wrong license
server.

Stop daemons (lmdown)
T he lmdown utility shuts down the License Manager daemon and the Citrix vendor daemon on your license server or all
license servers on your network but is disabled by default. To enable it:
1. Stop the license service.
2. Run lmadmin - allowStopServer and/or -allowRemoteStop Server.
3. Restart the license server.

Syntax

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.83

lmdown -c license_file_list [-vendor CITRIX] [-q] [-all]
Argument

Description

-c @localhost

Use the specified license files. Note that specifying -c license_file_list is always recommended with

or

lmdown. You can also use:-c @localhostor -c @server-name

-c@server
or
-c
license_ﬁle_list

-vendor
CIT RIX

Shut down only the Citrix vendor daemon. T he License Manager daemon continues to run.

-q

Do not prompt or print a header. Otherwise lmdown asks "Are you sure? [y/n]: ."

-all

If multiple servers are specified, automatically shuts down all of them. -q is implied with -all.

T he lmdown utility must be run on a license server. You can use -all to shut down all of the license servers on your network.
If lmdown encounters more than one server (for example if -c speciﬁes a directory with many *.lic ﬁles) and -all is not
speciﬁed, the utility displays a choice of license servers to shut down. You can shut down remote license servers by using -c
and specifying the name of the license server.
Note: If you use the T ask Manager to terminate the License Manager daemon (Citrix Licensing Service), stop the lmgrd
process first, then stop the Citrix vendor daemon process.
To stop and restart the Citrix vendor daemon only, use lmdown -c @localhost -vendor CIT RIX, then use lmreread -c
@localhost -vendor CIT RIX to restart the vendor daemon.

Check host names (lmhostid)
T he lmhostid utility returns the host ID of the license server. You can use the command to check the host name of your
license server. You can open a license ﬁle and compare the host name in the license ﬁle to that of your license server.
Note: Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if there are more than one
host.

Syntax
lmhostid -bindingidentifier
Argument
(bindingidentif ier)

Description

-ether

Used for product licenses that are tied to the MAC address of the appliance.

-internet

Used for Windows-based Citrix product software licenses that require a T CP/IP address.

-hostname

Used for Windows-based Citrix product software licenses that are tied to the hostnameof
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Argument
(bindingidentif ier)

the license server.
Description
Note: T he parameter hostname is case-sensitive and must match your license server name
exactly.

Reread license and options ﬁles (lmreread)
T he lmreread utility causes the Citrix vendor daemon to reread changes to the license ﬁle and the options ﬁle. After
rereading, the Citrix vendor daemon uses the new settings and/or licenses going forward.
lmreread cannot be used remotely; run it locally on the license server.

Syntax
lmreread -c license_file_list [-all] [-vendor CITRIX]
Argument

Description

-c @localhost or -c

Use the specified license files.

license_ﬁle_list

-all

If more than one lmgrd is specified, instructs all License Manager daemons to
reread.

-vendor CIT RIX

Specifies for the Citrix vendor daemon to be restarted.

Examples
lmreread -c @localhost [-all]
lmreread -c @client_access_point_name
lmreread -c /opt/citrix/licensing/myfiles/CIT RIX.lic -vendor CIT RIX

Display the list of licensing utilities (lmutil)
T he lmutil utility displays a list of licensing utilities when used standalone. When you specify lmutil with another command, it
executes that command.

Syntax
lmutil
lmutil other_command

Examples
lmutil
Displays all the licensing utilities.
lmutil lmstat -c @localhost
Executes the lmstat command.

Determine licensing status (lmstat)
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T he lmstat utility helps you monitor the status of all network licensing activities and provides you with information about
license check outs, including:
T he product that checked out one or more licenses
T he check out data
T he version of the license file
T he license server name and port
T he date the license was checked out
Information about the Citrix vendor daemon status and the license files
lmstat displays information that it receives from the license server. lmstat displays only one use of the license, even if there
are multiple connections sharing that license.

Syntax
lmstat [-a] [-c license_file_list] [-f [feature]] [-i [feature] [-s[server] [-S [CITRIX]] [-t timeout_value]
Argument

Description

-a

Displays all information.

-c @localhost or -c@server or

Uses the specified license files.

-c license_file_list
-f [feature]

Displays the products using a feature (product license). If feature is not specified,
usage information for all features is displayed.

-i [feature]

Displays information from the INCREMENT line for the specified feature (product
license) or all features if feature is not specified.

-s [server]

Displays status of all license files listed on the license server or on all license servers, if
server is not specified.

-S [CIT RIX]

Lists all product servers using the features (product licenses) served by the Citrix vendor
daemon.

-t timeout_value

Sets connection time-out to timeout_value. T his limits the amount of time lmstat
spends attempting to connect to the license server.

T he output of lmstat -c@localhost -a looks similar to:
License server status: 27000@license_server1
License files on license_server1: C:\Program Files\Citrix\Licensing\MyFiles\citrix_startup.lic:
C:\Program Files\Citrix\Licensing\MyFiles\citrixlic_20031001094430.lic:
license_server1: license server UP (MASTER) v9.2
Vendor daemon status (on license_server1):
CITRIX: UP v9.2
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Feature usage info:
Users of CITRIX: (Total of 5000 licenses issued; Total of 1 license in use)
"CITRIX" v2002.0101, vendor: CITRIX
floating license
MPS mps_server1 MPS MPS_ENT_2004.0227 (v1.0)
(license_server1/27000 101), start Tue 3/16 16:59
Users of MPS_ENT_CCU: (Total of 30 licenses issued; Total of 1 license in use)
"MPS_ENT_CCU" v2004.1201, vendor: CITRIX
floating license
MPS mps_server1 MPS 25fb337e:MPSCLIENT
(v2004.0227) (license_server1/27000 203), start
Wed 3/17 11:56
T he following represents a breakdown of the information contained in the MPS_ENT _CCU line of the lmstat output:
MPS

citrix_product_name

T he name of the Citrix product that has the license checked out.

mps_server1

hostname

Computer where the Citrix product is running.

MPS

display

T he name of the Citrix product that has the license checked out.

license_server1

server_host

Computer where the license server is running.

27000

port

T CP/IP port where the license server is running.

203

handle

License handle. T he license handle is a number used to identify a specific
checked out license.

start Wed 3/17

checkout_time

T ime that this license was first checked out.

11:56
Note: lmstat -c@localhost -a can potentially generate a lot of network activity in systems with many product licenses
checked out.
You can use lmstat -a to verify license check out data.

Display versions of binaries (lmver)
T he lmver utility displays version information for the licensing binaries, such as the command utilities. One exception is the
lmadmin utility. To display version information for the lmadmin utility, use lmadmin -version.

Syntax
lmver binary

Example
lmver lmdiag
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Display or release licenses f or users or devices (udadmin)
udadmin displays the licensed users and devices and releases licenses for speciﬁed users and devices.
You can release a license for a user only when the employee is no longer associated with the company or is on an extended
leave of absence. You can release licenses for devices only when the devices are out of service.
Caution: Mass releases of licenses, before the automatic 90-day lease period, outside of the reasons highlighted above
might violate the Citrix EULA. Before doing so, contact Citrix.
T he udadmin command-line help displays usage information only in English, but you can use the command on non-English
systems.

Syntax
udadmin [-options] [-delete | -list ]
Options

Description

-f feature name

When used with -list or -delete, displays or releases the license for only the user or device for the
specified feature name.

-user user name

Releases the license for only the user specified by the user name.

-device device

Releases the license for only the device specified by the device name.

name
-a

Lists all features and versions installed on the license server.

Argument

Description

-delete

Releases the license for one user, feature, or device at a time.

-list

Displays the users and devices with licenses and the time since the last update. T he time to the next
update appears if significant activity occurred within 15 minutes of the last report.

no

Displays usage information for the udadmin command.

argument
or ?

Examples
udadmin -list
Displays all the users and devices.
udadmin -list -a
Lists all features, versions, counts of licenses, and the users and devices for each feature.
udadmin -f XDT _ENT _UD -user u8.08 -delete
Releases one user from one feature.
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udadmin -f XDT _ENT _UD -device dn01.88 -delete
Releases one device from one feature.
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Clustered license servers
May 22, 20 17

Cluster servers are groups of computers that are combined to increase availability, reliability, and scalability. Microsoft
clustering functionality exists in:
Windows Server 2008
Windows Server 2008 R2
Windows Server 2012
Windows Server 2012 R2
Windows Server 2016
Clustering the License Server lets users continue working during failure situations without interrupting their access to critical
applications. When the active node in a cluster-enabled License Server suffers from hardware failure, failover occurs
automatically. Resources are available again in a few seconds.
A typical cluster conﬁguration has, at a minimum, one active and one passive (backup) server. When the active server in a
cluster fails, the ownership of the resources in the cluster are transferred to the backup (passive) server. Typically, users
cannot detect when one server in a cluster fails over to another.
When the active node of a clustered License Server fails, there is no impact on users connected to the Citrix product. T he
product may brieﬂy enter the licensing grace period and an event may be written in the product's event log.

Important
License Server VPX does not support clustered License Servers. You can use the High Availability (HA) feature on XenServer 5.6 and
later.

Citrix Licensing in a cluster
Like most clusters, a private network is used to send heartbeats, commands, and state information between the nodes of
the cluster. If the connection is interrupted, the nodes try to reconnect by the private network ﬁrst, then the public
network. T he following diagram illustrates a cluster-enabled licensing deployment:
Figure 1. Communications in a clustered licensing environment
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Only one node can use the resources in a cluster at any given time. If you already deployed Citrix Licensing and you want to
migrate your deployment to a cluster-enabled server, keep the following points in mind:
Because you already generated license files that reference a specific server name, you must either give the client access
point the same name as the original License Server or rehost your license files with the new name of the License Server
cluster.
Host names in license files are case-sensitive; therefore, the client access point names must be the same case as the
host names in the license file. If they are not, you must rehost your license files with the correct capitalization of the
names. You can use the Failover Cluster Manager to ensure the client access point name matches the host name
specified in the license file. Note: Cluster and host name case is not an issue if you use Studio in XenDesktop or the
Simple License Service (from the Start menu on your License Server) to download your licenses.
You must point all product installations (for example, servers running Citrix XenDesktop) serviced by the old License Server
to the new License Server cluster. Change product communication settings so that they use the name of the client
access point as the License Server name. For information about editing product-side communication settings, see the
product's documentation.

Opening the console or running commands
All licensing administration features available in standard deployments are also available on clustered License Servers,
including the management console and the ability to run license administration commands.
Open the License Administration Console in a cluster by browsing to:
https://client access point name:web service port
Where client access point name is the name of the cluster and web service port is the port number for console
communications (the default port number is 8082).
You can run many license administration commands using the argument -c @client access point name to specify the
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location of the license ﬁle(s) in the cluster. For example:
lmreread -c @client access point name -all

Requirements f or clustered License Servers
T he following list outlines the requirements for setting up a License Server in a Microsoft Cluster:
Citrix Licensing does not support Clustered Shared Volumes or third party Volume Management products for clusters.
Before configuring Citrix Licensing for Microsoft clustering, you must have a fully-functional Microsoft cluster
environment. Citrix Licensing Services runs on only one node at a time.
T o cluster the License Server, you must follow the following cluster requirements in addition to any requirements from
Microsoft for hardware and clustering in general.
You must install licensing on the cluster with the License Server installer CitrixLicensing.exe.
When you install Citrix Licensing on a cluster, you must specify the name of the client access point when prompted for
the name of the License Server during product installation.
Citrix recommends that you use identical License Server hardware for each node in the cluster. In particular, Citrix
recommends two network adapters on each node and the servers have one drive configured as a shared drive.
Each node should have two network adapters-one for connection to the public network and the other for the node-tonode private cluster network. Citrix does not support using one network adapter for both connections.
T he public and the private IP address must be on different subnets because the Cluster Service will recognize only one
network interface per subnet.
A name resolution method, such as DNS, WINS, HOST S, or LMHOST S, is necessary to resolve the client access point
name.
Each server that form the cluster must be in the same domain.
Set static IP addresses for the private network connector.
If you installed License Server build 20104 or later, we recommend that you use the Citrix Licensing Manager and your
license access code to allocate to the cluster.
When you generate a license file at citrix.com, use the name of the client access point when prompted for the Host ID.
After you download a license file, you must copy it to the F:\Program Files\Citrix\Licensing\MyFiles folder (where F: is the
shared drive for the cluster) on the License Server and reread it. Alternatively, use the License Administration Console to
download, copy, and reread the file.

Important
Citrix recommends setting static IP addresses for all network adapters in the cluster, both private and public. If IP addresses are
obtained by Dynamic Host Conﬁguration Protocol (DHCP), access to cluster nodes could become unavailable if the DHCP server
goes down. If you must use DHCP for your public network adapter, use long lease periods to assure that the dynamically assigned
lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reservation.

Overview of the clustering process
T he following steps describe the overall process involved in installing and configuring licensing on a cluster-enabled server.
T hese steps assume you configured the clustering on the hardware on which you intend to install the License Server.
1. Create a cluster resource group. Assign a client access point and shared storage to the resource group. Ensure that the
first node has control of the cluster resources and the resource group you created points to the first node.
2. On the first node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an administrator and install it on
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the first node to the shared cluster drive (not the quorum drive). Leave the Last Node in Cluster checkbox unchecked.
3. Move the resources from the active node in the cluster to the second node.
4. Install the License Server on the second node to the same shared location as the first node. Note that you can add
more than two nodes to a cluster.
5. When installing the License Server on the last node in the cluster, ensure that you check the Last Node in Cluster
checkbox.
6. Obtain license files that specify the client access point name of the License Server as the host name. After obtaining
license files, you must add them to the License Server and then reread them.
7. Configure your Citrix product to use the client access point name-not the node name-of the License Server cluster.

Important
When a clustered License Server fails over, the cluster service renames the lmgrd_debug.log to the name of the node that
previously hosted the services. T hen it starts the services on the new active node and creates a new lmgrd_debug.log.
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Install, upgrade, uninstall, and troubleshoot
May 22, 20 17

Install licensing on a clustered-enabled server
T he following drive letters and paths/variables are used in this procedure:
D is the drive for your product media.
C is the local hard drive on the specified node.
F is the cluster shared drive resource. (T his is the installation drive. T hat is, the place where installation files used by each
node are stored.)

Important
Because of a NetBios restriction, ensure the client access point name is fewer than 15 characters.

1. You must create a separate, noncore cluster resource group. T he resource group must have attached storage assigned a
drive letter and a client access point with the same hostname name used when obtaining the license ﬁle. Create this by
using the failover cluster manager and going to Services and applications in Windows 2008 or Roles in Windows 2012 and
select the Other Server type in the menu. Ensure all cluster resources are owned by the ﬁrst node of the cluster.
2. Run the License Server installer, CitrixLicensing.exe, as an administrator.
3. On the Install Location page, set the drive letter to correspond with the cluster shared drive. By default, the licensing
components are installed in F:\Program Files\Citrix\Licensing.
4. Leave the Last Node in Cluster checkbox unchecked during the installation on the ﬁrst node.
5. Move the resources for the resource group you created in Step 1 to the second node.
6. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.
7. Go back to Step 3. You can install more than two nodes on the cluster. You can install more than two nodes on the
cluster. For each additional cluster, repeat Step 3.
8. When installing the License Server on the last node in the cluster, ensure that the Last node in the cluster check box is
checked. T he last node is where the ports are conﬁgured.
9. If you installed License Server build 20104 or later, use the Citrix Licensing Manager to import your license ﬁles. Otherwise,
import your license ﬁles using the console and these steps.
1. Open the License Administration Console from http://client access point name:web service port, where client access
point name is the name of the cluster and web service port is the port number for the console Web server (8082 by
default).
2. Click Administration and choose the Vendor Daemon Conﬁguration tab.
3. Click Import License.
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4.

Click the citrix.com link.

5. On the My Account page, enter your user ID and password.
6. Select All Licensing Tools.
7. From the main menu, select Allocate.
8. Follow the process to allocate and generate your ﬁle. Select the licenses you want to download, click Download and
save generated license ﬁles to the shared drive of the cluster: F:\Program Files\Citrix\Licensing\MyFiles\.
9. In the License Administration Console on the Import License File page, browse to the license ﬁle.
10.Select Overwrite License File on License Server.
11. Click Import License.
10.Reread the license ﬁles.
1. Choose the Vendor Daemon Conﬁguration tab.
2. Click Administer in the CIT RIX vendor daemon line.
3. Click Reread License Files.

Upgrade a clustered License Server
If you are running a version of a License Server older than 11.12.1, uninstall it and then install this version. T he older versions
of the License Server do not conform to current Microsoft cluster guidelines.T his version of the License Server has the
functionality required to work with Windows Server 2008 and greater.

Uninstall a clustered License Server
Uninstall licensing from a clustered License Server using the Control Panel > Programs and Features option from the active
node.
Ensure the first node contains all the resources.
1. From the first node in the cluster, launch Control Panel > Programs and Features .
2. Remove Citrix Licensing.
3. Using the failover cluster manager, move the resources in the Citrix Licensing resource group to the second node.
4. Remove Citrix Licensing from the second node. If there are additional nodes, repeat Steps 3 and 4 for each node, and
then procede to Step 5.
5. Delete the remaining files from the shared drive.
Note: T he uninstallation process does not remove the license files and options file from the shared drive.

Troubleshoot cluster-enabled license servers

Important
If any of the licensing services fail to start, the cluster detects that licensing is ofﬂine and attempts to restart the service three times
(by default). If these attempts are unsuccessful, fail-over to the next node is initiated and the cluster attempts to start the services on
the second node. If the attempts fail on the second server, the process may enter into an inﬁnite loop. In this case, the computers
running Citrix products fall into the grace period. During the grace period, client connections are not affected.
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When troubleshooting a cluster-enabled license server, try the following:
If you move the resources to the other node, do you still see the issue?
Did you check the Use Network Name f or Computer Name check box in the Microsoft Cluster Server? See
http://support.microsoft.com/kb/198893.
If the installation fails, ensure you don't enable the User Account Control (UAC) when installing on a cluster.
For Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2016:
1. In the Failover Cluster Management window, from the left pane, select the cluster. In the middle pane, the summary
information for the cluster appears.
2. Click the Cluster Core Resources title to expand the section.
3. Verify that the cluster resources are all online (green arrow).
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Subscription Advantage
May 22, 20 17

When you purchase a new Citrix product, your purchase includes a one-year membership in Citrix Subscription Advantage.
T his membership entitles you to, among other beneﬁts, any product updates, including major and minor releases, released
during your membership period. For example, if you purchased XenDesktop, Enterprise edition on July 22, 2013, you are
entitled to any updates released for XenDesktop, Enterprise edition until July 21, 2014. After your initial one-year
membership period expires, you may choose to renew your Subscription Advantage membership. After paying Citrix for your
renewal, you can use the Citrix Licensing Manager to install your renewal licenses or you must go to citrix.com and
download a license ﬁle containing your renewal license.

Important
A Subscription Advantage membership and its associated license are distinct from your license to run the product. If you do not
renew your Subscription Advantage membership, your Citrix products do not stop working; however, you are not entitled to any
software releases after it expires.

Subscription Advantage renewal licenses
Subscription Advantage renewal license ﬁles contain licenses, known as renewal licenses, that extend your Subscription
Advantage membership for a one-year period. T hese licenses are required to run any new product releases, excluding
hotﬁxes, that are released during your membership period.
If you do not add the Subscription Advantage renewal licenses immediately, your Citrix products do not stop working.
However, you cannot run any new software released during your renewed membership until you have the renewal license
on your license server.
You do not need to download additional licenses when you install new versions of your products during this membership
period. If Citrix releases a product version after your Subscription Advantage membership ends, you must renew your
Subscription Advantage membership and obtain a renewal license before you can use the new product version.

Tip
When you download additional license ﬁles, you can delete the expired Subscription Advantage licenses; however, it is not a
requirement. You might want to keep them to make it easier to identify the upgrade that is associated with each base license.

You can ﬁnd out what your Subscription Advantage dates are:
In the License AdministrationConsole on the Dashboard.
Using a text editor to view the license file.

Check f or and install Subscription Advantage renewal licenses with the Citrix Licensing Manager
When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Subscription
Advantage renewal licenses.
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Based on how you conﬁgure it, the Citrix Licensing Manager automatically or manually checks for Subscription Advantage
renewal licenses and notiﬁes you or installs the licenses when found.
1. In the Citrix Licensing Manager, click the settings icon in the upper left of the UI.
2. Select how you want to be notified and if you want renewal licenses to be automically installed, and then click Save.
If the automatic checks for Subscription Advantage renewal licenses fail, check the ﬁrewall setting or conﬁgure a proxy. For
this feature to work, the License Server must be able to access https://citrixservices.citrix.com.
For more information, see Conﬁgure a proxy server.

Tip
You can also set the historical data retention period, language, and HT T PS port on this page.

Automatically check f or Subscription Advantage renewal licenses and notif y when available: Citrix Licensing
Manager displays a notification. Click on a link to download and install available renewals. Note that this same
notification appears in Studio and Director if they are configured to mange the License Server.
Automatically check f or and install Subscription Advantage renewal licenses when available: Citrix Licensing
Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days
stating that renewals have been installed.
Manually check f or Subscription Advantage renewal licenses: Select the Update License(s) tab and Check for
Available Renewals. You can check the Update License(s) tab at any time to see a list of licenses installed in the last 30
days.

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.98

Manually add Subscription Advantage renewal ﬁles
After you download your Subscription Advantage renewal license ﬁle from citrix.com, you must add it to your license server.
Copy the Subscription Advantage renewal license ﬁles to the same directory as your existing license ﬁles and reread the
license ﬁles. By default, this location is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server, C:\Program Files
(x86)\Citrix\Licensing\MyFiles on a 64-bit server and /opt/citrix/licensing/LS for License Server VPX. After you add the
renewal license to your license server, the license automatically unlocks any subsequent versions of the product released
during the Subscription Advantage period.

Renewing only part of your Subscription Advantage membership
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If you run products from two different releases in your environment (for example, you have a mixed XenDesktop
environment of versions 5.0 and 7.0) and you are not purchasing Subscription Advantage for all your licenses, Citrix
recommends that you separate the product licenses on two separate license servers. Subscription Advantage is applied to
the older product versions ﬁrst.
For example, if you own 200 licenses for 5.0 and you renew your Subscription Advantage membership for only 100 of those
licenses, it is possible that those 100 renewal licenses, which are required for 7.0, could be consumed by connections to
computers running 5.0.

To separate your licenses (two dif f erent licenses on two dif f erent servers)
1. Select a second server and install the license server software.
2. Go to citrix.com to reallocate your original licenses (these are the licenses contained in your current license file on the
original license server) and then reallocate the licenses into two new files:
Allocate licenses to your first License Server for your 5.0 deployment.
Allocate licenses to create another license file for the second License Server for your 7.0 deployment.
3. Generate and download your Subscription Advantage files and then copy them to the server to which you want them
applied.
4. Point all computers to the license server running the version of the Citrix product you want them to use. For information
about pointing your Citrix product server to the license server, see your Citrix product's administrator guide.
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Back up
May 22, 20 17

Depending on how crucial the applications associated with your licenses are, you may want to create backup License
Servers. Although Citrix stores backup copies of your licenses, downloading many replacement licenses can be timeconsuming. You can either store backup licenses on a network ﬁle share or have a conﬁgured backup License Server ready in
case of License Server failure.

Redundancy solutions
Setting up redundancy solutions might be necessary only in mission-critical environments. For smaller or less mission-critical
deployments, you can back up your License Server by creating a duplicate License Server that can be stored on or off the
network.
You can ensure redundancy for your mission-critical environments by:
Creating a clustered License Server. For more information about clustering and licensing, see Setting up the License
Server on a Microsoft Cluster.
Using the High Availability (HA) feature on XenServer 5.6 and later.
Duplicating the License Server and its contents - Give the duplicate computer the same name as the active License
Server and store it off the network.
Storing an additional License Server on the network with a different server name - In this case, when the active License
Server fails, you need to change the backup server name to start using it as the active License Server.
Using a network applicance - If you are using only one License Server to service license requests at any time, you can use
a network appliance that detects server or network outages and route traffic to a backup License Server.
All methods let you exchange one server license for another without a loss of service, provided the exchange occurs within
the grace period. T here are key points to remember:
Because license files reference the server specified during allocation, you can use the files only on a server with the same
binding information (server name or FQDN or MAC address (possibly displayed on the portal as Ethernet address) as the
original License Server
You cannot have two License Servers with the same name on your network active at the same time
You must add any additional licenses that you download to both the active License Server and the backup License Server

https://docs.citrix.com

© 1999-2017 Citrix Systems, Inc. All rights reserved.

p.101

FAQ for Licensing
May 22, 20 17

T hese questions are asked frequently about your licensing environment.

Can I rename the license server?
License ﬁles run only on the license server for which they were made. More speciﬁcally, license ﬁles contain the hostname or
binding identiﬁer of the license server you specify when you allocate the licenses. You cannot use the license ﬁle that you
generated, which speciﬁes a particular license server name, or a MAC address (in the case of an appliance.), with a different
license server name or appliance.
Create license ﬁles that reference the new server name or MAC address by reallocating and generating the new ﬁle on
citrix.com.

If I upgrade my license server does it af f ect my license ﬁles?
No. T he license server and all product licenses are fully backward compatible and do not introduce any issues into your
environment.

Can a single license server supply licenses to users connecting f rom dif f erent servers using dif f erent
product editions?
Yes. One license server can contain licenses for multiple editions of a Citrix product. T he type of license checked out
corresponds to the edition that is conﬁgured on the product server. A product server is conﬁgured to consume an edition of
a license and checks out that edition of a license.
For example:
ProductServerA is conﬁgured to check out Enterprise licenses.
ProductServerB is conﬁgured to check out Platinum licenses.
LicenseServer1 contains both Enterprise and Platinum licenses.
Users who connect to LicenseServer1 from ProductServerA check out Enterprise licenses only. After the number of
Enterprise licenses on LicenseServer1 is exceeded, new requests from ProductServerA users are denied until existing
Enterprise connection licenses are released.
Users who connect to LicenseServer1 from ProductServerB check out Platinum licenses only. If the number of Platinum
licenses on LicenseServer1 is exceeded, new requests from ProductServerB users are denied until Platinum connection
licenses are released.

Note
License checkout times might increase if many product servers with many users are contacting the same license server
simultaneously. One license server can accept only 10,000 inbound TCP/IP requests at one time. If you are planning to have more
than 10,000 Citrix product servers (XenApp, XenDesktop, Delivery Controllers, Appliances) connecting at the same time, we
recommend that you use several license servers.
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Examples of Possible Deployments:
Scenario 1: Two farms
FarmA contains product servers configured for Enterprise edition
FarmB contains product servers configured for Platinum edition
One license server (shared)
User1, User2, User3, User4...User5000 connect only to FarmA
User5001, User5002, User5003...User10000 connect only to FarmB
Scenario 2: One farm
T he farm has two sets of published applications
Product servers configured for Enterprise edition host one set of applications
Product servers configured for Platinum edition host one set of applications
One license server (shared)
User1, User2, User3, User4...User5000 connect only to product servers that have the first set of applications
User5001, User5002, User5003...User10000 connect only to product servers that have the second set of applications

Dif f erences in License Server version numbers
T he License Administration Console and the Windows Programs and Features display different version numbers, but they
display the same build number to aid in identiﬁcation.

We use two different versioning systems for our licensing technology:
T he License Administration Console and the registry version key use the License Server version plus an internal build
number (11.13.1 build 16002 in the previous graphic).
Internally and for the MSI, we use the Licensing SDK version and our build number (11.1.0.1 build 16002 in the previous
graphic).
To avoid confusion, we recommend using the License Administration Console or registry to ﬁnd your correct version number.
For more information, see Finding information for your version of licensing.
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